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The information in this publication is provided for reference only. All information
contained in this publication is believed to be correct and complete. Thermo
Nicolet Corporation shall not be liable for errors contained herein nor for incidental
or consequential damages in connection with the furnishing, performance or use of
this material. All product specifications, as well as the information contained in this
publication, are subject to change without notice.

This publication may contain or reference information and products protected by
copyrights or patents and does not convey any license under the patent rights of
Thermo Nicolet Corporation, nor the rights of others. Thermo Nicolet Corporation
does not assume any liability arising out of any infringements of patents or other
rights of third parties.

Thermo Nicolet Corporation makes no warranty of any kind with regard to this
material, including but not limited to the implied' warranties of merchantability and
fitness for a particular purpose.

Copyright © 1998 by Thermo Nicolet Corporation, Madison WI 53711. Printed in
the United States of America. All world rights reserved. No part of this publication
may be stored in a retrieval system, transmitted, or reproduced in any way,
including but not limited to photocopy, photograph, magnetic or other record,
without the prior written permission of Thermo Nicolet Corporation.

Address comments to:

Documentation Group
Thermo Nicolet Corporation
5225-4 Verona Road
Madison WI 53711-4495

OMNIC is a registered trademark of Thermo Nicolet Corporation.

Avatar, Integra, Ever-Glo, PLUS, Snap-In, Sync and E.S.P. are trademarks of
Thérmo Nicolet Corporation.

Windows is a registered trademark of Microsoft Corporation.

Intel and Pentium are registered trademarks of Inte] Corporation.

PS/2 is a registered trademark of International Business Machines Corporation.

The Sync module on a Smart accessory is a factory-programmed, read-only device
that does not allow a write operation from the spectrometer.

269-088702
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Welcome to Avatar 360!

Congratulations on your purchase of an Avatar™ 360 E.S.P.™
spectrometer! The spectrometer lets you collect spectra in either the
mid-IR or near-IR spectral ranges. The E.S.P. system integrates
advanced hardware features with the power and flexibility of
Nicolet’s OMNIC® software’.

This manual explains how to use the system to collect and process
your FT-IR data after the spectrometer is installed. Included is
information about using Nicolet’s OMNIC E.S.P. software as well
as chapters on how to operate, maintain and service the
spectrometer.

* Some dedicated systems, such as the Liquid Analysis System, use other Nicolet
software packages.

Avatar 360 System User’s Guide 1
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If you have
questions or

concerns

Conventions
used in this manual

Note

A Caution

A Warning

Nicolet

A Danger

If you have any questions or concerns about your Avatar
spectrometer, contact Nicolet Customer Support at one of the
numbers below. Outside the U.S.A. call your local sales or service
representative. Telephone numbers for all Nicolet Customer
Support offices are provided with your system.

e Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538)

e Fax: 1-608-273-6045
e World Wide Web:  http://www.nicolet.com
e E-mail: nicinfo@nicolet.com

The following conventions are used in this manual to draw your
attention to the on-line documentation and other important
information.

This symbol (shown enlarged here) tells you that you can find more
information in the on-line tutorials or OMNIC Help system. You
can access all of the on-line tutorials as well as the Help system by
clicking the Help menu in OMNIC.

Messages like this contain helpful supplementary information about
a procedure or technique. a

Follow the instructions given in Cautions to avoid damaging the
spectrometer or losing data. a

Always heed the Warnings that appear in this manual to avoid being
injured while using the spectrometer. a

Follow the instructions labeled Danger to avoid serious injury or
loss of life while using the spectrometer. a

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com
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Installing OMNIC

If you purchased your computer from Nicolet, your software is
already installed. If you provided your own computer, you will need
to install OMNIC on your hard drive. These same instructions can
be used should you ever need to reinstall OMNIC.

1. Start your Windows software

2. Insert the CD entitled Disc 1: Software and Libraries (the
OMNIC CD) into the drive.

The installation starts automatically.
If the installation does not start within 20 seconds, or if you are
installing the software from floppy disks, use the Add/Remove

Programs dialog box to install OMNIC.

1. Click the Start button and choose Control Panel from
Settings.

2. Double-click the Add/Remove Programs icon, and then
choose the Install/Uninstall tab in the window.

3. Click the Install button and follow the directions to install
the OMNIC software.

Avatar 360 System User’s Guide 3

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



Starting OMNIC To start OMNIC:

Nicolet

1.

Start your Windows software.

Double-click the OMNIC E.S.P. shortcut.

The OMNIC shortcut is on the Windows desktop.

7

OMNIC
E2F

Depending on how the program has been configured, dialog
boxes may appear asking for a user name and password. Type in
your user name if requested, and then choose OK. If your
program is password protected, enter your password.

The OMNIC window appears. The OMNIC window is described
in the “Getting Started” tutorial in the Help menu.

The Avatar Installation Wizard may also appear on the screen. It
contains instructions for installing your spectrometer and
confirming its operation. The wizard can be turned off by
clicking the check box on the last page of the tutorial. If you
turn off the tutorial, you can still access it at any time from the
Avatar Installation Wizard shortcut on the Windows desktop.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com
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The OMNIC window

Spectral window

Menu bar

Experiment list box

The large window that appears on the screen when you start OMNIC
is called the OMNIC window.

£ OMNIC - PWindowl]

4060 3500 3000 2500 2000 1500 1000 500

Within the OMNIC window is a spectral window, which you can use
to display and manipulate spectra. When a spectrum is displayed in
a spectral window, you can use OMNIC commands to perform
operations on it. For example, you can change the spectrum’s
format or search it against a spectral library to identify it.

Below the title bar is the menu bar, which contains all of the
OMNIC menu names. The menus are arranged in an order that
you’ll find convenient as you use the software. All of the menu
commands are explained in detail in the on-line tutorials or the
OMNIC Help system.

Below the menu bar is the Experiment drop-down list box. The
Experiment drop-down list contains all of the experiment files you
have opened, plus the default experiment file and an experiment file

Avatar 360 System User’s Guide 5
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Bench status

O
X

Note

Toolbar

Accessing
on-line information

Nicolet

for any Smart accessory you have installed. By selecting an
experiment with this feature, you can quickly set the software
parameters for the type of experiment you want to perform. You
can see the parameter settings for the selected experiment by using
Experiment Setup from the toolbar or from the Collect menu.

To the right of the Experiment drop-down list box is the Bench
Status indicator. The indicator is a green check mark when the
spectrometer is operating properly. If there is a problem with the
spectrometer, the indicator turns to a yellow circle or red X. A
yellow circle indicates that the spectrometer has failed a
performance test, but the failure is usually not serious enough to
prevent you from collecting usable spectra. A red X indicates that
the spectrometer has failed a performance test that requires
corrective action. Diagnostic information appears allowing you to
troubleshoot the problem.

If you wish to view the on-line videos to help you in troubleshooting
a problem, put the Spectrometers Tutorials CD in the computer. a

Below the Experiment drop-down list box is the toolbar. Each
button in the toolbar represents the action taken by a corresponding
command or feature. To see the name of the command or feature for
a button, point to the button and wait a moment. To initiate the
command or feature, click the button with the left mouse button.

The on-line and printed documentation included with your system is
designed to let you find the information you need quickly. We
recommend first using the on-line documentation provided with
OMNIC when you have a question. OMNIC includes a variety of
multimedia on-line tutorials, wizards and a complete Help system.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com
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Wizards and tutorials

Most of the wizards and tutorials can be accessed through the
OMNIC Help menu. Others, like the Avatar Installation Wizard can
be accessed using a short cut.

The wizards and tutorials teach you how to do these things:

Avatar Installation Wizard — This tutorial starts automatically
whenever you start OMNIC and walks you step-by-step through
installing your spectrometer yourself and confirming that the
spectrometer is operating properly. Use the check box on the last
page of the tutorial if you do not want to see this tutorial each time
you start OMNIC. You can start this tutorial at any time by double-
clicking the Avatar Installation Wizard short cut.

Getting Started — The “Getting Started” tutorial introduces you to
the OMNIC E.S.P. software. This tutorial includes basic
information about the OMNIC window, using the toolbar and tool
palette, creating and using spectral libraries, creating your own
experiment files, and using on-line laboratory notebooks to create
and save reports.

Spectrometer Tour — When you finish this tutorial, you will be
familiar with all of the components in your spectrometer.

Beginner’s Guide to FT-IR — Run this tutorial to learn how an
FT-IR spectrometer works and the theory behind FT-IR
spectroscopy.

Sampling Techniques — This tutorial helps you choose the best
sampling technique for your analysis. It also describes how to
install and use Avatar and other Smart Accessories.

Learning OMNIC — Use this tutorial to get information about using
various OMNIC features to collect, display and process spectra.

Installing optional hardware — This tutorial contains step-by-step
instructions for installing optional hardware and setting up your
spectrometer for a variety of experiments. On-line video help is
provided for most procedures.

Avatar 360 System User’s Guide 7
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Note

Replacing parts — Use this tutorial when you want to change
replaceable parts. It also includes on-line video help and
instructions for maintenance procedures such as cleaning your
spectrometer and checking and changing the desiccant and purge
filters.

Troubleshooting — If you ever have a problem with your
spectrometer, use this tutorial to access troubleshooting information
and get part number and ordering information.

Technical Support — This tutorial outlines the many support,
training, and custom application services available from Nicolet. It
includes Technical Support telephone and fax numbers, as well as
e-mail and web site addresses.

You must have the CD entitled Disc 2: Spectrometer Tutorials and
Drivers in the computer to use the multi-media capabilities of the
Installation Wizard, the Spectrometer Tour or any of the parts
replacement or sample handling tutorials. a

To use a tutorial, point to the Help menu and then choose the desired
tutorial from the list that appears. You can access a variety of tutorials
from the Learning OMNIC and Choosing a Sampling Technique items
in the Help menu. You can also start tutorials from within other parts
of the on-line documentation provided with OMNIC.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com
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OMNIC Help topics

The OMNIC on-line Help system lets you quickly find answers to
your questions about using the software. There are several ways to
enter the Help system:

You can see information about a particular feature in OMNIC
(such as a parameter in a dialog box) by clicking the item using
the right mouse button. A brief description of the item appears,
and in most cases one or more buttons that you can click to
display more detailed information. Here is an example:

' Displays the X and Y values of the pointer location. §

Click the Discussion button to display a complete discussion of
the item (or the dialog box or window that contains the feature).
Click the How To button to display a step-by-step procedure for
using the item (or the dialog box or window that contains the
item).

You can press the F1 function key at any time to see a discussion
topic for the currently displayed or selected feature, dialog box
or window.

If a dialog box or window contains a Help button, click it to see
information about the dialog box or window (or the command
that displayed it).

To see the Contents of the OMNIC Help system, choose OMNIC
Help Topics from the Help menu. Here is an example of the
Contents tab displayed in Windows 95 showing the contents of some
of the books in the system:

Avatar 360 System User’s Guide 9

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



10

Nicolet

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com

Help Topics: OMNIC Help

| % Introduction
; Q Tutorials
@ Troubleshiooting software and applications prablems
@ Diagnostic, alignment and spsterm configuration features
¢ @ Opening and saving spectra
@ Selecting spectra
% Viewing data and using the display
1 [J,J Collecting data
] ’Z"ﬂ Selecting an experiment
rﬂ Monitoring the bench status
% Setting the experiment parameters
@

f_] Dizcussion

Z’:] How To
Q Collecting a background spectrum

You can also check parts lists or find other information without
using the computer connected to the spectrometer. Insert the Disc 2:
Spectrometer Tutorials and Drivers CD into any Windows 95,
Windows 98 or NT computer and double-click the icon for the

following programs:

P360_ENU.HLP Part numbers and hardware setup and

S360_ENU.EXE Spectrometer tour
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If you purchased
EZ OMNIC E.S.P.

The EZ OMNIC E.S.P. version of OMNIC includes the features
needed to perform many common spectroscopy tasks. If you
purchased EZ OMNIC E.S.P., some of the features described in this
manual are not available. In some cases a described command is not
in the menu. In other cases certain features do not appear in the dialog
boxes for a command. Read and follow the instructions for the
features that are available. Here are some other things you should be
aware of when using the software:

The toolbar is always displayed when you use EZ OMNIC E.S.P. It
provides a convenient way to initiate menu commands, macros and
external programs. You can use Edit Toolbar in the Edit menu to
add available menu commands, macros, DDE commands or other
programs. You can also specify the size of the toolbar buttons and
whether text or icons, or both, appear on the buttons.

If you change the toolbar, you are asked when you exit EZ OMNIC
E.S.P. whether to save the changes (the prompt refers to this as
saving the “configuration”). Choose Yes if you want the toolbar
changes to appear the next time you start OMNIC.

Spectral searches you perform with Search in the Analyze menu (or
with the Search button in the Library Setup dialog box) are always
carried out using the search expert. The search expert determines
the search algorithm to use for the best result and which spectral
regions to search. When the search is complete, the library spectra
found by the search are displayed along with the search expert’s
comments.

A special command called Create Library appears in the Analyze
menu of EZ OMNIC E.S.P. to allow you to create a user library.
When you choose this command, the Library Creation Wizard
appears. The Wizard takes you through the steps of creating a
search library or QC library.

While EZ OMNIC E.S.P. cannot be used with Macros\Basic to

create new executable macros, you can run existing macros.

Avatar 360 System User’s Guide 11
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A Warning

Note

Your First Experiment

The Spectrometer Safety Guide that came with your system contains
important safety information. This guide is available in several
languages. Contact your local Nicolet office for information about
the languages that are available. Before you use the system, read the
entire guide. To prevent personal injury and damage to equipment,
follow the safety precautions contained in the guide whenever you
use the system. a

It’s easy to collect spectra with your Avatar spectrometer. By
leaving the system turned on at all times—with the needed
components already installed—you can keep it ready to use with a
minimum of preparation. Keeping the system on also improves its
stability and gives you more consistent results.

If you have a dedicated system (such as a Liquid Analysis System)
that normally uses a software package other than OMNIC E.S.P.,
skip this chapter. a

In this first experiment you will:

Select an experiment.

Collect a background spectrum.
Collect a sample spectrum.

Save the sample spectrum in a file.

You can learn all these things and more by running the on-line
tutorials provided with OMNIC. Start with the “Getting Started”
and “Spectrometer Tour” tutorials available in the OMNIC Help
menu.

Avatar 360 System User’s Guide 13
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check before
you collect spectra

Selecting
an experiment

14 Nicolet

All the things you need to check before you collect spectra are listed
below. By the time you have run through these items once or twice
in the course of your work, you will know how to check the system
and start collecting spectra quickly.

Cool the detector (if you are using an MCT detector).

e Make sure the spectrometer, computer and printer are turned on
and OMNIC is started.

e Check the Power and Scan indicator lights on the spectrometer
front panel. The Power light should be on, and the Scan light
should be on continuously or flashing. If the lights are not
performing in this way, follow the troubleshooting messages that
appear on the screen, run the “Troubleshooting” tutorial in the
OMNIC Help menu, or see the “Hardware Troubleshooting”
chapter of this manual for instructions.

e Check the purge filter and humidity indicator.

For step-by-step instructions for each of these items, run the
“Replacing parts” tutorial available in the OMNIC Help menu.

The parameters for spectral data collection are stored in experiment
files. You load the parameters you wish use when you select an
experiment file from the Experiment drop-down list box below the
OMNIC menu bar. A number of experiments are provided with
OMNIC, and you can create and save your own.

Experimant | Default - Transmission

‘Default - Transmission

If you want to check or change the parameters after selecting an
experiment, use Experiment Setup from the toolbar or the Collect
menu.

To learn more, see the “Collecting a Spectrum” tutorial. If you need
to change a source or detector, see the “Replacing parts” tutorial.

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



) ) J)J)J)J)J)J)J)J)J)J)lyldlilJ)ll)l)))

. JJJJdJII ]

)

)

Note

Collecting a
background
spectrum

The most commonly used hardware configuration for mid-IR
experiments includes a KBr beamsplitter, an Ever-Glo (mid-IR)
source and a DTGS detector. You may need to change the settings of
the example experiment if your hardware configuration is different. a

A sample spectrum is usually ratioed against a background spectrum.
The background spectrum measures the response of the spectrometer
without a sample in place. Dividing the sample spectrum by the
background—called “ratioing”—removes the effects caused by the
instrument and atmospheric conditions so that the peaks in the final
spectrum are due solely to the sample.

Here is a typical background spectrum:
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For most applications you don’t need to collect a new background
spectrum for each sample spectrum if you haven’t changed the
software parameters. To obtain good results, however, collect a new
background regularly, perhaps once every four hours. (You can
obtain the best results by collecting a new background for each
sample, but this is seldom necessary.)

Whenever you collect a background spectrum, make sure that the

sample compartment is empty You can initiate background data
collection at any time using the Collect Background button.

Avatar 360 System User’s Guide 15
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If you are using separate Snap In™ sample compartment baseplates
for different accessories and sample holders, you can quickly switch
baseplates to install the sample holder. For information about using
Snap-In baseplates, choose Replacing Parts from the OMNIC Help
menu. Then choose the “Removing the Snap-In baseplate” topic
from the “Replacing parts” book.

In the data collection procedure that follows, you will select an
experiment and then collect a background spectrum and a
polystyrene sample spectrum.

You can also learn how to collect spectra by using the “Collecting a
Spectrum” tutorial available through the Learning OMNIC item in
the Help menu.

Follow these steps to collect the sample spectrum:

1. Select an experiment from the Experiment drop-down list
box.

Click the arrow button at the right end of the Experiment drop-
down list box.

‘Expetiment: | Default - Transmission

‘Default - Transmission

The Default - Transmission experiment appears in the list. A
number of other experiments are included with OMNIC E.S.P.
for performing a wide variety of data collections. You can open
these experiments by choosing Open in the Experiment Setup
dialog box. You can also use Experiment Setup to set up and
save your own experiments.

Select an experiment by clicking it.
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If you select the Default - Transmission experiment, the
parameters in the Experiment Setup dialog box are now set
correctly for collecting a polystyrene sample spectrum.

You can check the settings of the parameters by choosing
Experiment Setup from the toolbar or the Collect menu.

The data collection parameters, along with the other experiment
parameters, determine how OMNIC collects background and
sample spectra. See the OMNIC Help system for complete
information about the parameters.

In the Default - Transmission experiment the Collect
Background Before Every Sample option is selected. This
option prompts you to collect a background spectrum before you
collect a sample spectrum

Click the Collect Sample button in the toolbar to begin
collecting the sample spectrum.

The Collect Sample window appears and then a dialog box
showing the default title for the sample spectrum:

: Callect Sample

t
hu Jul 24 14:55:08 1997

Avatar 360 System User’s Guide 17
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Nicolet

3. Type a title in the text box or choose OK to accept the

default title for the spectrum.

Since the Default - Transmission experiment specifies that a
background should be collected before every sample, a message
appears now asking you to prepare to collect a background
spectrum.

Confirmation

(9} Backgiound
‘ " Please prepare to collect the background spectm.

This means that you need to remove any sample from the sample
holder so that the infrared beam path is clear.

When you then collect a background spectrum, the resultis a
measurement of the response of the spectrometer alone; that is,
without absorptions due to a sample.
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4. Look through the sliding door to make sure there is no
sample in the sample holder and then choose OK to start
data collection.

If there is a sample in the sample holder, open the sliding door,
remove the sample, close the sliding door, and then choose OK.
If your spectrometer is purged, leave the sliding door open about
1 cm (1/4 to 1/2 inch) and wait 1 minute before choosing OK.

A background spectrum appears in the Collect Sample window.
The spectrum is updated as more data are collected. When all
the background data have been collected, a message appears
asking you to prepare to collect the sample spectrum.

Avatar 360 System User’s Guide 19
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5. Install the sample.
First open the sliding door.
Next insert the sample into the sample holder. If you are
collecting a polystyrene spectrum using the standard samples

that came with your spectrometer, insert the 1.5 mil standard.

Then close the sliding door.

View the “Installing Samples” unit of the “Spectrometer Tour”
tutorial for more information about installing samples.

If your spectrometer is equipped with a purge kit, allow 1 minute
for the purge to reach equilibrium before going to the next step.
If carbon dioxide and water vapor interfere with the spectral data
from your sample, you would need to wait 3 to 5 minutes.

Nicolet

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com

I |

(

(



d )2 A1 33I323T3I1I3dI33323331333333F33) %3

6. Choose OK to start sample data collection.

As data are collected, the sample spectrum in the Collect Sample
window is updated. Here is the Collect Sample window during
sample data collection:

# OMNIC - [Collect Sample]

~ Ahsorbance

|

!
: fidt
i I

I

i il
; ~eined bt ENPPNON L A D WP L
3500 3000 2500 2000 1500 1000
Wavenumbers {cm-1)

Collection gauge Tool palette View finder Collect Status indicator
Sample spectrum
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7. Monitor the status of the data collection.

The progress of the collection is indicated visually by the
collection gauge above the tool palette. The number of scans
collected so far and the total number of scans for the collection
are displayed to the right of the gauge.

When all the sample data have been collected, the following
message appears asking whether to add the spectrum to a
spectral window:

| Confirmation

Data collection has stopped.
Add to Window1? : ’

View Collect Status |

o Nn § {:mcdi |

8. Choose Yes to add the sample spectrum to the spectral
window.

(Choosing No ends the procedure without saving the spectrum.
Choosing Cancel returns you to the Collect Sample window,
allowing you to collect more scans with the More button.)

22 Nicolet
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How do I know if my
spectral data is good?

XOSN

Here is the sample spectrum displayed in the spectral window:

#+ OMNIC - [Window1]
dit Collect View Process Anslyze SST  Beport Sen

efault - Transmission

Y Transmittance

The Collect Status indicator above the view finder shows the status
of the collection during and after collection. The indicator is a green
check mark, showing that the spectrum has passed all of the selected
spectral quality checks made so far. After the collection is finished
and the indicator is a green check mark, you can add the spectrum to
a spectral window (if it is not automatically added).

If you ever have a problem with data collection, the Collect Status
indicator may change. If the indicator is a yellow circle, the
spectrum has failed a spectral quality check (a measured value was
not within the allowed range), but it is not serious enough to stop the
collection.

If the indicator is a red X, there is a problem with the quality of the
spectrum. After correcting the problem, collect the spectrum again.

To view information about the collection, including any problems

that have occurred, click the indicator during or after the collection,
or click the View Collect Status button.

Avatar 360 System User’s Guide 23
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When all the sample data have been collected, the following
message appears asking whether to add the spectrum to a spectral
window:

onfirmation

_ Data collection hasvstoppad

Clicking the View Collect Status button displays the Results
window, showing a summary of any problems encountered during
data collection and other information about the collection.

T R .

vvvvvvvvv ﬁx;zer:merﬁ wie ‘fransmiwm = : ;

Experirssnt desenption This is the delaak Bxpeiment e
Expotiviant windgw: Mang - o

Expeviment aucassony: ?@we ]

'ﬁamgie Results

x ?ha :miar[amgmm araplitude is below the specified rangs.

| Eaploin |
A Allowed rnge; 28 By
APeghvane. 11 ;

fﬁ%r:kgmmi Hesafts

] {:) “The ;nxe:femgram peak i gatwateet
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Saving the spectrum

You can save your spectrum manually on the hard disk by using
either of two commands in the File menu: Save or Save As.

Use Save when you want to save a spectrum on the disk using the
current filename and path. In this example you will use Save As to
save a spectrum in a file on the disk using a new filename.

Follow these steps to save the spectrum you just collected:

1. Select the spectrum using the left mouse button.

2. Choose Save As from the File menu.

The Save As dialog box appears.

. Type a descriptive name (for example POLY.SPA) for the

spectrum.

Enter the name following the directory path in the File Name
box so that the text reads C:\OMNIC\SPECTRA\POLY.SPA.

The text can be either upper or lower case. The default directory
path for saving files is determined by the settings on the File tab
of the Options dialog box, available through Options in the Edit
menu.

. Choose OK.

If you typed a filename that already exists in the directory, a
message appears asking whether to replace the existing file.
Choose No and then use a different filename to save the
spectrum.

Avatar 360 System User’s Guide 25
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Converting a
spectrum's units

Using Other Basic Features of OMNIC

Once you know how to collect and save spectra, you can use other
basic OMNIC features to:

convert the spectrum’s units

annotate the spectrum

create and use spectral libraries

create and view on-line laboratory notebooks, and

The spectra you collect using the Default - Transmission experiment
are in absorbance units, since many OMNIC data manipulation
commands work best on spectra in absorbance units. Often it is
useful to convert a spectrum to other units. For this example you
will convert the spectrum to % transmittance units.

1. Select the spectrum by clicking it.

2. Choose the Transmittance button in the toolbar.

You can also choose % Transmittance from the Process menu.
The spectrum is converted to % transmittance units.

The toolbar buttons and the Process menu allow you to convert
spectra to several other units as well. In the OMNIC Help system
Index, find “converting spectrum” and go to the topic discussing the
units to convert to.

Choose the Absorbance button to return the spectrum to absorbance

units so that the spectrum is ready for you to learn to label a peak in
the next exercise.

Avatar 360 System User’s Guide 27
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Labeling 1 The palette contains six tools that let you select a spectrum or spectral
) region, change how spectra are displayed in a spectral window, find
peak with the  the height or area of a peak, or label a peak. The names and
annotation tool  appearance of the palette tools indicate their functions.

Selection  Spectral cursor Peak area

Region Peak height | Annotation

Only one tool can be used at a time. To use a tool, first select it by
clicking it. A tool remains selected until you select another tool.

When you use a tool, the readout above the palette may display
information for the tool operation; for example, the X and Y values
of the pointer location or the limits of the selected spectral region.
Here is an example of X and Y values displayed in the readout when
the selection tool is selected:

X{736.294) Y:(1.168)

Nicolet
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Follow these steps to label a peak in the polystyrene spectrum:

1.

Select the annotation tool by clicking it.

The annotation tool in the palette lets you label peaks with their
frequency locations (X values) or other information.

When the annotation tool is selected and you move the pointer
into a pane of a spectral window, the pointer looks like this:

R

You can label a peak by clicking above it with the annotation
tool. This displays the label text above the peak with a line
connecting the label to the peak. The text is selected so that you
can immediately edit it. When you press Enter, the label appears
in its final form.

You can more accurately locate the top of a peak by holding
down the Shift key when you click near the peak.

Label the peak near 2,924 wavenumbers by holding down
the Shift key and clicking a little above the peak.

The label appears:

Absaorbance
w
S

29 E

jg‘i\i{ \!ﬁ\_ ﬁnﬂWL/JR\/‘*’\Mjkﬂf»v! 1}L\--»’l !

4000 300 000 2600 2000 1500 1000 500
o avomembare (em-1)
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Using libraries

Nicolet

Note

3. Press Enter to accept the label text.

To modify the label, edit the selected text before pressing Enter.
To modify an existing label, select the Annotation tool and click
the label you want to change. Type a new label and then press
Enter.

To delete a label, select the Annotation tool and click the label.
Then press the Delete key.

In the OMNIC Help system Index, find “tool, annotation” and go to
the “Annotation tool” topic for more information about the
annotation tool.

In the next section, you will learn about using spectral libraries.

Spectra are often used to identify an unknown sample or to confirm
a known sample’s composition. To accomplish these tasks, the
sample spectrum is compared with reference spectra contained in a

library.

Libraries are collections of reference spectra. They may be a
collection of commercially collected reference spectra, reference
spectra you collected under controlled conditions, or simply a
collection of spectra that you wish to store in an organized manner.

OMNIC E.S.P. allows you to create three different types of spectral
libraries.

e Search libraries
e Quality control (QC) libraries

e Scrapbook libraries

Scrapbook libraries are not available if you are using EZ OMNIC. a
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Searching

Comparing

Search libraries are most often used to identify an unknown spectrum.
If you were unsure of the composition of the sample, you could
perform a “spectral search” using a search library.

OMNIC gives you the choice of using the “search expert” to
determine how to perform a spectral search and the kinds of search
results to display, or specifying the search parameters and results
yourself. Unless you have special needs, we suggest that you use the
search expert. When a search is complete, the expert displays a
number of library spectra that best match the unknown spectrum,
plus comments about the search results. For example, the search
expert may tell you that the best match is excellent but the second
best match is also similar to the unknown.

In the OMNIC Help system Index, find “library, searching” and go
to the “Searching a spectral library” topic if you want more
information about identifying sample spectra with search libraries.

QC (QC Compare) libraries let you verify the composition of materials.
These libraries are useful for quality control operations in which you
know what a sample should contain and just need to verify and
document the composition.

Spectra in QC libraries are stored in groups called “‘compound types”.
This allows you to maintain reference spectra that reflect variables in
or tolerances allowed for your samples. The software then compares
your sample spectrum with the reference spectra in each compound
type and reports the best compound type match.

QC comparisons are also useful for detecting minute differences in
spectra. If you need to detect small changes (in the parts per million
range) in your samples or identify samples that are spectroscopically
very similar, you could create a QC library with as few as one
reference spectrum in each compound type.

In the OMNIC Help system Index, find “QC comparison” and go to the
“Performing a QC comparison” topic if you want more information.
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Browsing Scrapbook libraries are a convenient place to store and organize
your spectra when you are using OMNIC E.S.P. spectroscopy
software. You can add any spectrum to a scrapbook library; the
resolution and other parameters do not matter.

After adding spectra to a scrapbook library, you can find them by
searching for text stored with the spectra. You cannot perform a
spectral data search of a scrapbook library.

OMNIC’s Library Manager (available in the Analyze menu) gives
you the ability to view the spectra and related information contained
in commercial and user libraries of spectra.

Note Library Manager is not available with EZ OMNIC. a

In the OMNIC Help system Index, find “library, searching for text
in” and go to the “Searching a library for text” topic if you want
more information about organizing sample spectra in scrapbook
libraries.

Creating a Both OMNIC E.S.P. and EZ OMNIC E.S.P. include a Library
. Creation Wizard that makes it easy to create your own spectral
user library 2~ . : .
ibraries. Creating your own library lets you customize the
information in the library depending on your needs. You set the
library parameters (including the resolution and spectral range) and
specify which checks and corrections are to be performed. The
Library Creation Wizard leads you step-by-step through the process.
To access the Library Creation Wizard using OMNIC E.S.P.:
1. Open Library Manager.

Choose Library Manager from the Analyze menu.

2. Choose Create Library on the Library Names tab.

32 Nicolet
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Adding a
spectrum to a library

Note

To access the Library Creation Wizard using EZ OMNIC:

Choose Create Library from the Analyze menu.

In the OMNIC Help system Index, find “library,creating” and go to the
“Creating a user library” topic if you want more information about
creating libraries and using the Library Creation Wizard.

Once you have created a user library, you can use the library to store
spectra you collected. To do this, select the spectrum and then choose
Add To Library from the Analyze menu. To move a copy of a
spectrum you collected from one user library into another user library,
choose Library Manager from the Analyze menu.

You cannot add spectra to a commercial library nor can you move
copies of commercially collected reference spectra into libraries you
create. o

In the OMNIC Help system Index, find “ adding, spectrum to user
library” and go to the “Adding library spectra a user library” topic or
the “Adding spectra to a user library (Add to Library)” topic if you
want more information about storing spectra in libraries.
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Creating and OMNIC makes it easy to create and print a report containing the
results of your work.

printing a report
1. Choose Template from the Report menu.

A dialog box appears allowing you to locate and select a report
template for the report.

2. Go to the C:\OMNIC\REPORT directory and select the
report template file named SEARCH1.RPT.

This file contains a report template specially set up for this
procedure. It includes items for the spectral window, spectrum
time, title and comments, and search results.

When you select a report template file, a preview image of the
template appears at the right. This feature allows you to see
what different templates look like so that you can pick one with
the items you need for your report. You can view the image as a
graphical layout by selecting the Layout option. This shows you
how the printed report will look on paper. You can also view
the image with template items labeled by selecting the
Description option. This lets you identify items that are too
small to be seen clearly.

3. Choose Select to make the example template the current
template for printing reports.

When you print your report, OMNIC automatically fills in the
items in the template with the appropriate information and
images. For example, if an item in the template is linked to the
active spectral window, the contents of that window appear on
paper when you print the report.

You can create your own report templates by using the Create
button, or you can modify one of the existing templates
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whenever you want to design a new template. Save the template
with a new name after you make your changes.

In the OMNIC Help system Index, find “report template,
selecting” and go to the “Selecting, editing or creating a report
template” topic for more information about using reports.

Choose Preview/Print Report from the Report menu.
A preview of the report appears showing the report items filled

in with information about your spectrum. Your report should
look similar to this: '

POl ymee 0 3 3 TR

2000
Wavenumbers (cm-1)

T

The preview lets you check the content of the report before
printing it. You can click the Zoom button to see an enlarged
image of the report.

If you have a printer connected, choose Print to print the
report.
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The Print dialog box appears allowing you to set some
parameters that affect printing.

6. Choose OK.

The report is printed on your system printer.
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Major
spectrometer
components

Spectrometer Basics

This chapter introduces the major components of your spectrometer,
including the light source, interferometer and detector. It also
describes how to turn on the spectrometer and what happens when
the spectrometer starts up.

View the “Spectrometer Tour” tutorial for complete descriptions of
your spectrometer’s internal and external components.

The following illustration shows an Avatar 360 spectrometer from
the front.

sliding door

External

Sample beam port

compartment
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What’s inside? The illustration below shons a top view of the optical layout of the
Avatar 360 spectrometer with covers removed to reveal components.
The solid black line shows the path of the infrared beam.

Electronics Infared Interferometer
module source compariment Interferometer

\ \ \ /

i \ \ \ L &

: A\ \ Vi lJ Optional
] 1 automated
=/ B2 | aperture

| 1 Desiccant

Laser
power supply~\.|

Source

Laser )
| L— focus mirror

| Humidity
11 indicator

Optional
automated
external
beam mirror

Detector\

Detector

Mirror™\|

™\ Smart chip
reader

Sync module

fSample_
ocus mirr
Optiona AR
validation wheel

Smart chip reader

Sample compartment Sample holder

View the “Inside the spectrometer” unit of the “Spectrometer Tour”
tutorial for complete descriptions of your spectrometer components.
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What is on
the rear panel?

Turning on
the system
components

The following illustration shows the locations of the connectors,
purge kit input, and power switch on the spectrometer rear panel.

Cooling vents for
electronic's module

il

Computer Accessory Power Power Purge
detector supply supply kit
indicators

View “The back panel” unit of the “Spectrometer Tour” tutorial for
complete descriptions the rear panel components.

We recommend that you keep your spectrometer on at all times,
unless the building is subject to power outages or you need to
perform a service or maintenance procedure. Leaving the system on
keeps it stable and gives you the most consistent results. If you must
turn the spectrometer off, allow it to stabilize for at least 15 minutes
(one hour for best results) before collecting spectra.

Follow these steps to turn on the system components:

1. Turn on any accessories you plan to use.

This includes accessories such as an infrared microscope or
Liquid Analysis System.
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2. Turn on the computer and printer.

Turn on the computer and printer as explained in the
documentation that came with those components.

3. Turn on the spectrometer by pressing the power switch (1/0).

| =on
0 = off

A Warning  Always follow the safety precautions described in this manual and in
the Spectrometer Safety Guide that came with your system. a

Nicolet
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A Caution

Note

A Warning

Never block the cooling vents.

Electronics module

The electronics module inside the spectrometer could overheat. a

After you turn on the spectrometer, let it warm up for 15 minutes
(one hour for best results) before collecting data. a

Do not operate the spectrometer without following the safety
precautions described in this manual and in the Spectrometer Safety
Guide that came with your system. a

When you turn on the spectrometer, the status indicators—Power
and Scan—flash in various sequences as the system runs through its
diagnostic routines. When the routines are finished, the Power
indicator stays lighted. You can start your spectroscopy software
(OMNIC, EZ OMNIC, or other Nicolet software) as soon as the
diagnostic routines finish.

View the “Powering Up” unit of the “Spectrometer Tour”
tutorial for complete instructions on turning on your system.
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Note

Note

The system enters a “stand-by” mode 10 minutes after data
collection activity has ceased. This mode continues for 1 hour.
After 1 hour, the interferometer stops scanning and the scan light
stays on. Any data collection activity will cause the interferometer
to begin scanning. Exiting OMNIC also activates stand-by mode. a

If the Power indicator flashes or will not light at all, or if the Scan
indicator will not light, the Bench Status indicator will show a red X
and troubleshooting tips will appear on the screen. If you cannot
resolve the problem, contact Nicolet at one of the numbers below.
Outside the U.S.A. call your local sales or service representative.
Telephone numbers for all Nicolet Customer Support offices are
provided with your system.

o Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538)
¢ Fax: 1-608-273-6045

e World Wide Web:  http://www.nicolet.com

¢ E-mail: nicinfo@nicolet.com a
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Using sources
and detectors

More About Your Spectrometer

This chapter explains what you will need to know before collecting
data in various spectral ranges. It includes information about
hardware changes you can make to improve the precision and
accuracy of your spectral data.

The Avatar 360 spectrometer is available with a single internal
source, a single internal detector, and a permanently installed
beamsplitter. The source and the detector can be changed to allow
you to study a broader spectral range with one instrument.
However, not all beamsplitters, detectors, and sources can be used
together. Some detectors can accommodate only a portion of the
energy from the source and may require installing an energy filter.
Be sure to select a detector-source combination that is compatible
with the beamsplitter that is installed in the spectrometer.

If you need to install or change a source or detector, choose
Replacing Parts from the OMNIC Help menu and view the tutorial
in the “Replacing parts” book.

In the OMNIC Help system Index, find “source” and go to the

“Specifying the source type” topic for instructions on using different
sources in your spectrometer.
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Selecting the There are two considerations when selecting a source-beamsplitter-
detector combination: compatibility and spectral range.

right detector
The following table lists the spectral ranges of compatible source-
beamsplitter-detector combinations.
Light Range  Beamsplitter ~ Detector Spectral Range (cm”)  Source
near-IR CaFy MCT-Af 11,700 - 1,200* Ever-Glo,
white light
mid-IR KBr DTGS-KBr 7,400 - 350 Ever-Glo
MCT-A% 7,400 - 600 Ever-Glo

Notes:

*  This spectral range reflects the combination of the ranges of the Ever-Glo and white light sources, as well as
the limits of the beamsplitter-detector combination. The range achieved using one of these sources will not be
as broad as the total range shown.

¥  These detectors must be cooled with liquid nitrogen before use.

Improving If you are using the spectrometer for quantitative analysis or other
. demanding applications, you are concerned with the precision and
the quahty of accuracy of your spectra. For these types of applications it is
important that the spectra you collect are photometrically accurate.
JOAE SpECtI‘ﬂl data This means that the frequency axis (X-axis) location of peaks in a
spectrum is consistently reproducible and within IUPAC
(International Union of Pure and Applied Chemistry) published
specifications. You must also be certain that your spectrometer
responds linearly to the samples you are studying. This means that
absorption band intensity is directly proportional to the number of
molecules subjected to the light beam; thus, as the number of
molecules in the beam increases, the detected absorbance signal also
increases.

If you are studying samples that produce tiny spectral peaks, have
weak spectral features, or if you are looking for small changes in
your samples, you want to be sure that the signal-to-noise ratio is
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How to improve the
signal-to-noise ratio

Note

high enough so that you can distinguish spectral features from the
noise inherent in all experimental data. This prevents the signals
containing spectral information from being lost among the signals
generated by the random movement of electrons, by building
vibrations, by light source fluctuations, and other such sources.

Avatar 360 detectors can be optimized to produce a more linear
response and greater photometric accuracy, or to increase the
signal-to-noise ratio.

If you primarily analyze qualitative data, you may wish to optimize
the system for a better signal-to-noise ratio. This can be particularly
important when you are working with scattering samples and
samples that absorb more infrared energy. These samples produce
smaller signals that can be “lost” in the noise.

There are several ways to improve the signal-to-noise ratio. The
most commonly used method is to increase the number of scans.
This both reduces the noise level and makes small absorptions easier
to distinguish. You can also improve the ratio by reducing the
resolution (using a larger Resolution setting).

Another method is to use an energy screen that transmits more light
(or no screen at all). In this case, the resulting spectrum might be
distorted and accuracy and stability could be reduced. Checking the
single-beam baseline in the region below the low-end cutoff will
give you a rough idea of how much distortion is occurring. If the
distance from the baseline to O is more than 15% of the spectrum’s
maximum intensity value, you may have difficulty reproducing the
results. Screens generally are not needed for DTGS detectors.

If the distance from the baseline to O is greater than 20% of the
spectrum’s maximum intensity value, your detector electronics may
be overloaded. Contact Nicolet Customer Support for assistance. a

See “Setting up for experiments” available through Installing Hardware in
the Help menu for instructions for installing filters and energy screens.
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photometric accuracy
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Note

Some detectors (including PbSe and MCT-A detectors) are highly
sensitive and can become saturated or produce a distorted (nonlinear
and photometrically inaccurate) signal if the light energy is not
reduced before it reaches the detector element.

Look at a single-beam spectrum in the low-end region around 600 to
350 cm-1. You should see a straight line very near 0. As a rule of
thumb, the distance from O to the baseline should be less than 1% of
the spectrum’s maximum intensity value. If the detector is
saturated, you will see false energy in the low-end region. The
baseline might be far above zero.

The maximum intensity of a mid-IR single-beam spectrum is
typically found near 2,000 cm-1. a

The distorted signal may cause problems with photometric accuracy.
For good quantitative data, the sample and background
interferograms should be about the same size. Scattering samples
and very dense samples produce very small signals that, when
compared with much larger background signals, can distort
quantitative data.

Check the background and sample interferograms. If you see a
substantial difference in their size, photometric accuracy could be a
problem.
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When to use
bandwidth-limiting filters

When to use
energy screens

To solve these problems, Avatar 360 spectrometers allow the
following options for modifying the infrared beam:

e Install a bandwidth-limiting filter.
o Install an energy screen.

See “Setting up for experiments” available through Installing
Hardware in the Help menu for instructions for installing filters and
energy screens.

In some cases, system performance improves if you use a filter or
screen. The filter or screen that you should use for your application
depends on the samples being measured and other experimental
conditions. Try using various filters or screens to determine which
give the best results for your application.

Use bandwidth-limiting filters to improve the signal-to-noise ratio of
the data and also prevent detector saturation by allowing only energy
in your particular area of interest to pass to the detector element.

See “Setting up for experiments” available through Installing
Hardware in the Help menu for instructions on installing filters.

Depending on the types of detectors you use, your system may
include a set of four energy screens. These metal screens help
prevent detector saturation and signal distortion by blocking out a
portion of the energy at all frequencies of the infrared beam. If your
experiments deal with information from a broad range of
frequencies, these screens may be the most effective means of
reducing the light level.

The energy screens are labeled A, B, C and D. The following table
shows the percentage of the infrared energy that each screen passes.
It also lists the detectors typically used with each screen, as a
starting point for correcting linearity problems.
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mirror velocity
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Screen % Transmitted*  Detectors Typically Used With Screen

none 100 DTGS
A 30 MCT-A
B 10
C 3
D

* These are nominal values that may vary due to diffraction and detector variations.

To correct for photometric accuracy, you may need to add a
“heavier” screen (one that transmits less infrared energy). With
corrections for photometric accuracy you will notice some reduction
in the signal-to-noise ratio but will obtain more reliable quantitative
data. Generally, the signal-to-noise ratio is reduced less than is the
signal intensity.

See “Setting up for experiments” available through Installing
Hardware in the Help menu for instructions on installing energy
screens.

Several moving mirror velocities are available for Avatar
spectrometers. When you switch to a different detector, OMNIC
automatically resets the default spectral range in the Experiment
Setup dialog box. Be sure to check the range and set the velocity to
a value that is appropriate.

For DTGS detectors, the Velocity parameter values should be 0.63
or less. Higher velocities cause a decrease in the detector’s
sensitivity and increase the noise in your spectrum. To specify the
velocity and spectral range, use the Velocity and Spectral Range
settings on the Bench tab in the Experiment Setup dialog box. To
specify the resolution, use the Resolution setting on the Bench tab.
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Avatar Smart
Accessories

Accessories You Can Buy
and How to Install Them

This chapter briefly describes the types of sampling and system
accessories that are available for your spectrometer. Complete
descriptions and operating instructions are included with the
accessories.

A variety of “Smart” accessories have been designed specifically for
your Avatar spectrometer.

The new Avatar Smart Accessories take a generational leap forward
to provide easy sample preparation and complete, reliable sampling

performance. The Avatar system uses E.S.P. technology to identify
each Avatar accessory as soon as it is installed. When you “snap in”
an Avatar Smart Accessory, you are ready to collect data. No more

time is wasted aligning accessories and setting parameter files.

Avatar Multi-Bounce HATR — This attenuated total reflection
spectroscopy accessory is ideal for rapid quantitative and qualitative
analyses, since sample preparation is usually not necessary. Itis
well suited for a range of solids and liquids. Analyzing liquids,
pastes, gels, films, and soft powders is effortless. This accessory is
available with a Trough Plate Kit for analyzing liquids, pastes and
gels; a Flat Plate Kit for analyzing films and coatings on flat
samples; or a Combination Kit for a variety of liquid and solid
samples. The Trough Plate and Combination Kits include a volatile
liquid cover and a powder press. Zinc selenide (ZnSe) is the
standard crystal material for this accessory. Germanium (Ge)
crystals are available as an option for measuring samples with a high
refractive index.
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Avatar Single Bounce HATR — This attenuated total reflection
spectroscopy accessory is recommended for analyzing samples with
strongly absorbing spectral peaks. It is also useful for analyzing
discreet areas (8 mm or larger) such as a spot on a film. It is well
suited for analyzing neat solvents, aqueous solutions, pastes, gels,
films, and hard samples. The shorter, single-reflection pathlength
produces absorbance values that are within the linearity of the FT-IR
technique and therefore permits more complete and accurate spectral
subtractions. This high quality subtracted data can be readily
searched against library data bases. Both ZnSe and Ge crystals are
available for this accessory.

Avatar Diffuse Reflectance — The Avatar Diffuse Reflectance
accessory is highly effective at maximizing diffusely scattered
radiation, while minimizing specular reflected radiation (a source of
spectral interference). Samples can be analyzed as is, with a slight
amount of grinding, or by grinding and mixing with potassium
bromide (KBr). The technique is applicable for both organic and
inorganic materials. The kit includes a Si-Carb™ sampling tool (for
the analysis of solid materials such as paint chips and any inflexible
sample that can be abraded with silicon carbide paper) two sample
slides, adhesive-backed silicon carbide disks, and pre-measured and
sealed KBr packets.

For instructions on installing E.S.P. accessories, choose Replacing
Parts from the OMNIC Help menu. Then choose the “Installing
optional hardware” topic from the “Replacing parts” book.

You can install many of the sampling accessories yourself. After
you install an accessory, you might have to align it. Instructions for
aligning the spectrometer are included in the “Service and
Maintenance” chapter of this manual. Instructions for aligning an
accessory are provided in the documentation that came with that
accessory.
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Note

Most accessories fit into the sample compartment, but some require
separate housing and optics. Nicolet offers microscopes and liquid
analysis systems with the Avatar 360.

Some accessories have their own optics. The optional automated
external beam mirror inside the spectrometer redirect the light beam
from the internal light source through a port on the right side of the
spectrometer. The beam then travels into the accessory’s optics.

Some of the accessories fit into the sample compartment and require
that you remove the standard Snap-In baseplate before installing the
accessory. For instructions on using Snap-In baseplates, choose
Replacing Parts from the OMNIC Help menu. Then choose the
“Removing the snap-in baseplate” topic from the “Replacing parts”
book.

Call Nicolet if you are interested in ordering any of the following
sampling accessories.

Additional Snap-In sample compartment baseplates are available for
use with each accessory to make changing accessories easier. a

Gas cells — A variety of short- and long-pathlength gas cells are
available. Cells include built-in transfer optics that fit into your
spectrometer sample compartment. The cells are suitable for use in
both ambient and elevated temperature conditions. Gas cell heating,
transfer optics purge, gas manifold, and sample window options are
available to accommodate a variety of sample gases and sampling
conditions.

Gemini — By combining two sampling technologies—horizontal
attenuated total reflection (HATR) and diffuse reflection—this
accessory lets you analyze a broad range of sample types. The
Gemini is baseplate-mounted for high stability, and no accessory
realignment is necessary when you switch sampling heads. Integral
purge tubes seal the accessory from the atmosphere.

IR microscopes — Nicolet offers microscopes that attach directly to
the spectrometer. The microscopes provide fast, nondestructive
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microanalysis with minimal sample preparation and alignment. The
beam path is switched from the spectrometer to the microscope
module through the OMNIC software.

Liquid analysis system — The Nicolet Liquid Analysis System lets
you collect and process quantitative analysis data for liquid samples.
The System uses the OMNIC Integra™ software, which contains
methods designed for quantifying components in specific types of
liquids. The System can include a Programmable Liquid Uptake
System (PLUS™) and an autosampler for automating liquid sample
handling.

Specular reflection — Specular reflection provides a
nondestructive method for measuring surface coatings without
sample preparation. It can be used to analyze surface-treated metals,
paints, semiconductors, and resin and polymer coatings. Specular
reflection accessories can be installed in the spectrometer sample
compartment.

Transmission — Transmission is the oldest and most efficient
sampling technique in FT-IR spectroscopy and can be used for
sampling liquids, gases or solids. A variety of cells and sample
holders are available for transmission analysis. All can be mounted
in the spectrometer sample compartment.

The standard transmission baseplate is an E.S.P. accessory. E.S.P.
accessories are automatically recognized by the Avatar 360 E.S.P.
spectrometer and OMNIC E.S.P. software. The system
automatically selects the correct operating parameters for the system
when the Transmission E.S.P. baseplate is installed. Also, a series
of spectral quality checks are performed to ensure that the accessory
is installed and operating correctly.

Validation wheel — The validation wheel is used with Nicolet’s
System Validation software to validate the performance of the
spectrometer. The wheel automatically moves standard samples into
the beam path at the appropriate times during the validation
procedure. You can choose a validation wheel permanently installed

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com



)

J

)0 JJ)J)J)J)J)J)J)l)l)

) 333033

JJJ)J)))

System accessories

in the detector compartment, or one that mounts in the sample
compartment.

For instructions on installing E.S.P. accessories, choose Replacing
Parts from the OMNIC Help menu. Then choose the “Installing
optional hardware” topic from the “Replacing parts” book.

Some system accessories are installed by Nicolet. Call Nicolet if
you are interested in ordering any of the following accessories.

Automated aperture — This option allows you to perform high
resolution (0.5 cm-1) experiments.

Automated external beam mirror — If you have a microscope,
Liquid Analysis System or other accessory with an external detector,
this option is required. It directs the IR beam out the port on the
side of the spectrometer to the accessory whenever you select it.

Power line conditioner — Power line conditioners protect your
spectrometer and other accessories from damage or malfunction due
to voltage dropouts, transient spikes, frequency shifts or other
disturbances in your electrical service.

Uninterruptable power supply — An uninterruptable power
supply reduces the chance of a system shutdown if power is lost
elsewhere in the building.

Purge kit — This kit includes all the hardware you need to regulate
the pressure and flow of purge gas for your spectrometer. If you
have difficulty controlling humidity in your laboratory or have a
laboratory environment that is contaminated with solvents or other
agents that can corrode spectrometer components, protect your
spectrometer with a purge kit. Damage caused by humidity or
corrosive agents is not covered by your Nicolet warranty.

Pure air dryer — Nicolet offers dry-air systems. If you have

difficulty controlling moisture in your laboratory, the pure air dryer
provides additional protection for the hygroscopic elements of your
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spectrometer. This accessory is also useful if your laboratory air
supply is contaminated with volatile solvents, oil or other reactive
materials.

Purge gas generator — If you do not have in-house facilities to
supply compressed air or nitrogen for system purge, Nicolet offers
several purge gas generators. These systems include an air
compressor and an air dryer.

RSVP Remote diagnostics — This option uses a data modem and
remote control software to allow control of your computer (and

spectrometer) through the modem link. An analog telephone line is
required.
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Collecting spectra

Quick Answers to Your Questions
About Using OMNIC E.S.P.

This chapter presents common questions and answers about using
the OMNIC software. Each question is followed by a brief answer,
plus a reference for where you can go for more information.

How do I set the software for collecting spectra?

You can set the software in one step by selecting a stored experiment
from the Experiment drop-down list box below the OMNIC window
menu bar. To set the experiment parameters individually, use
Experiment Setup from the toolbar or from the Collect menu.

View the “Preparing the Software” unit of the “Collecting a
Spectrum” tutorial for information about setting the software for
collecting spectra.

In the OMNIC Help system Index, find “selecting, experiment” and
go to the “Selecting an experiment” topic, or find “experiment,
parameters” and go to the “Setting the experiment parameters” topic.

How do I collect a spectrum?

Set the parameters as explained above and then choose Collect Sample
from the toolbar or from the Collect menu. Depending on the
parameter settings, you may need to install or remove the sample
before choosing Collect Sample.

View the “Collecting the Spectrum of a Sample” unit of the

“Collecting a Spectrum” tutorial for information about collecting
spectra.
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In the OMNIC Help system Index, find “collecting, spectrum” and
go to the “Collecting a sample spectrum” topic or “Collecting a
background spectrum” topic.

How do I specify the Y-axis unit for collecting spectra?

Choose Experiment Setup from toolbar or Collect menu and then set
Final Format on the Collect tab.

You can change the format of a collected spectrum by using
Absorbance, % Transmittance or Other Conversions in the Process
menu. See the question and answer in the next section for a
description of the available units.

View the “Typical IR Transmission Spectrum” unit of the
“Collecting a Spectrum” tutorial.

In the OMNIC Help system Index, find “Y-axis, unit” and go to the
“Selecting a final format” topic.

What does gain do?

Gain amplifies the detector signal intensity, making it larger relative
to the level of electronic noise. This is helpful when the signal is
weak, such as when you use some sampling accessories. You can let
OMNIC automatically adjust the gain to maximize the signal by
setting the Gain parameter to Autogain. We recommend using this
setting to ensure the best spectral quality.

View the “Setting the Instrument Gain” unit of the “Collecting a
Spectrum” tutorial.

In the OMNIC Help system Index, find “gain” and go to the “Setting
the gain” topic.

When should I save interferograms with my spectra?
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Save interferograms if you think you may want to restore the
original data after it has been processed or if you want to keep an
archive of your raw data. This setting increases the size of files
stored on your hard disk.

View the “Setting parameters for automatic saving” lesson of the
“Preparing the Software” unit of the “Collecting a Spectrum”
tutorial.

In the OMNIC Help system Index, find “saving, interferograms” and
go to the “File handling” topic.

What does the Collect Sample window show?

The window displays the “live” spectrum as it is being collected plus
a gauge indicating the progress of the collection, an indicator
showing whether any problems have occurred and other information
about the collection.

View the “Collecting the Spectrum of a Sample” unit of the
“Collecting a Spectrum” tutorial.

In the OMNIC Help system Index, find “collecting, sample
spectrum” and go to the “Collecting a sample spectrum” topic.

How do I know my spectra are meeting quality standards?

OMNIC continuously monitors the quality of the data you collect,
based on the parameters you set. The Quality tab in the Experiment
Setup dialog box contains parameters for specifying the spectral
quality characteristics that you want checked when you collect
spectra.
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OMNIC offers four categories of spectral quality checks:

Spectrum checks
Parameter checks
Background checks
Interferogram checks

When OMNIC performs a check and detects a problem, the Collect
Status indicator is displayed as a yellow circle or a red X. Click the
indicator (or click the View Collect Status button at the end of data
collection) to see a summary of data collection problems
encountered during the collection and other information about the
collection.

In the OMNIC Help system Index, find “quality” and go to the
“Quality tab” topic.

Which Y-axis unit should I use for a spectrum?

The most commonly used units are % transmittance and absorbance.

Use % transmittance if you plan to compare the spectrum visually
with published reference spectra. Use absorbance units for
quantitative analysis measurements.

Kubelka-Munk units are useful for searching diffuse reflectance
spectra against libraries of absorbance spectra.

Percent reflectance units are mathematically equivalent to
% transmittance units, but using them for spectra collected using a
reflection technique serves to identify the sampling technique.

Using log (1/R) units for spectra collected using a reflection
technique is useful for quantitative comparisons, since there is often
a linear relationship between the concentration of a component and
its log (1/R) value.
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Using
spectral libraries

View the “Typical IR Transmission Spectrum” unit of the
“Collecting a Spectrum” tutorial.

In the OMNIC Help system Index...

e Find “absorbance” and go to the “Converting spectra to
absorbance” topic.

e Find “transmittance (%)” and go to the “Converting spectra to
% transmittance” topic.

e Find “Kubelka-Munk units” and go to the “Kubelka-Munk units”
topic.

e Find “reflectance (%)” and go to the “% Reflectance units”
topic.

e Find “log (1/R) units” and go to the “Log (1/R) units” topic.

How do I search a spectral library?

First prepare the spectrum (as explained below) and display or select
the region you want searched. Then set up the search using Library
Setup in the Analyze menu and start the search by choosing Search
from the Analyze menu.

In the OMNIC Help system Index, find “searching, spectral library”

and go to the “Setting up a library search” topic or “Searching a
spectral library” topic.

How should I prepare my spectrum before searching it against a
spectral library?

There are several corrections you can perform on a spectrum to
obtain the best search results:

If the baseline of the spectrum is sloped, curved or shifted vertically,
correct it using Baseline Correct in the Process menu.
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In the OMNIC Help system Index, find “correcting, baseline” and go
to the “Correcting a baseline manually” topic.

If the spectrum has totally absorbing bands, eliminate them by using
Blank in the Process menu. Be careful not to blank regions that
contain other important spectral information.

In the OMNIC Help system Index, find “blanking spectral region”
and go to the “Blanking a spectral region” topic.

You can also use the region tool to select a region of the spectrum
that does not include any totally absorbing bands or use the view
finder to display the region before searching. (These methods avoid
the loss of spectral information that results from blanking.)

In the OMNIC Help system Index, find “selecting, spectral region”
and go to the “Region tool” topic, or find “displaying, spectral
region” and go to the “View finder” topic.

If you collected the spectrum using specular or diffuse reflection, use
Kramers-Kronig (dispersion) transformation (available through
Other Corrections in the Process menu) to correct it for dispersion
effects and then search it against a library of absorbance spectra.

In the OMNIC Help system Index, find “Kramers-Kronig
transformation” and go to the “Kramers-Kronig (dispersion)
transformation” topic.

If you collected the spectrum using ATR (attenuated total reflection),
use ATR correction (available through Other Corrections in the
Process menu) to correct it for variation in the depth of penetration
and then search it against a library of transmission spectra.

View the “Using an ATR Accessory” tutorial for information about
using your ATR. In the OMNIC Help system Index, find “ATR
correction” and go to the “ATR correction” topic.

If the spectrum has water or carbon dioxide peaks, use Other
Corrections to remove these peaks.
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In the OMNIC Help system Index, find “water” and go to the “H20
and CO2 correction” topic.

Only those portions of the spectrum which are within the selected
region (or displayed region if no region is selected) and within any
of the regions you specified for the library using the Region Setup
tab of the Library Setup dialog box will be included in the search. If
the spectral range of the spectrum is broader than that of the library
spectra, use the region tool to select the region of the spectrum that
coincides with the library spectra before you start the search. You
can also use the view finder to display the region to search. The
Search command operates on the selected region, or on the displayed
region if a region is not selected.

In the OMNIC Help system Index, find “selecting, spectral region”
and go to the “Region tool” topic, or find “displaying, spectral
region” and go to the “View finder” topic.

How do I create a spectral library?

For OMNIC E.S.P. users, use the Create Library button on the
Library Names tab of Library Manager to create a user library.

For EZ OMNIC E.S.P. users, use Create Library from the Analyze
menu.

When you create a library, you determine the kinds of information
that will be saved with it. Once the library is created use Add To
Library from the Analyze menu to put your spectra into it.

In the OMNIC Help system Index, find “user library, creating” and
go to the “Creating a user library” topic.
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How can I display a library spectrum in a spectral window?

Locate and select the spectrum in Library Manager and then click
the Add To Window button, or go to the Library Spectra tab of
Library Manager, display the desired spectrum on the tab and then
double-click the spectrum.

In the OMNIC Help system Index, find “displaying, library
spectrum” and go to the “Working with libraries” topic.

How can I find a compound in a commercial library?

Library Manager in the Analyze menu lets you search for the
compound name. After you select the library on the Library Names
tab, use the features on the Search For Text tab to locate the
spectrum. Type the text to search for in the Text In Selected Item
box, and then choose Search. The search results appear in the table
based on the options you have set. To see information about a found
spectrum, double-click its row in the table.

In the OMNIC Help system Index, find “searching, spectral library”
and go to the “Searching a library for text” topic.

You can use the extended search feature (available on the Extended
Search tab of the Library Setup dialog box) to find library spectra by
searching for text in any field included in the library. For example,
some libraries have fields for molecular weight, boiling point or
manufacturer.

In the OMNIC Help system Index, find “extended search” and go to
the “Using extended search” topic.

What is the easiest way to collect sample spectra and add them
to a spectral library?

Use the Collect Spectrum button on the Library Names tab of
Library Manager to collect a spectrum and add it to a user library.
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Opening, saving and
deleting spectra

The software automatically sets the experiment parameters (for
example, Resolution) so that the spectrum will be compatible with
the selected library. This allows you to collect and add a compatible
spectrum in one step instead of three (using Experiment Setup to set
the parameters, Collect Sample to collect the spectrum and Add To
Library to add the spectrum to the library).

In the OMNIC Help system Index, find “collecting, spectrum” and
go to the “Working with libraries” topic.

What does the search expert do?

It determines the spectral regions to search, searches those regions
and then displays the specified number of library spectra that best
match the unknown spectrum, plus comments about the search
results. For example, the search expert may tell you that the best
match is excellent but the second best match is also similar to the
unknown. You will be able to display the list of matches to see their
match values and index numbers.

How do I open a stored spectrum?

Choose Open from the File menu (or click the Open button in the
toolbar if it is displayed), locate the spectrum or spectra you want to
open, select the filenames of the spectra and then choose OK. You
can also hold down the Control key and select multiple files to open.

In the OMNIC Help system Index, find “opening, spectrum” and go
to the “Opening spectra” topic.
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How can I automatically save my collected spectra?

Choose Experiment Setup from the toolbar or the Collect menu and
turn on Save Automatically on the Collect tab (Save Automatically is

on by default). Specify a base name for naming the saved spectral data

files in the Base Name box. A sequential number will be appended to
the base name when the spectra are saved. If you want the
interferograms saved with the spectra, turn on Save Interferograms.
Individual spectra are saved with the extension .SPA.

View the “Setting parameters for automatic saving” lesson in the
“Preparing the Software” unit of the “Collecting a Spectrum”
tutorial.

In the OMNIC Help system Index, find “saving, spectra” and go to
the “File handling” topic.

Where should I save my spectra?

You have several options for saving spectra; you may choose to use
more than one. For a permanent record of the spectrum and any
other information you want to record, use a report notebook.

In the OMNIC Help system Index, find “report notebook” and go to
the “Adding a report to a notebook” topic.

You can also place spectra in descriptively named user libraries that
you create. Keeping spectra in libraries allows you to find them by
searching for text contained in the information saved with the
spectra.

In the OMNIC Help system Index, find “spectrum” and go to the
“Adding a spectrum to a user library” topic.

We recommend that you create descriptively named folders
(directories) on your hard disk for different categories of spectra.
For example, you could have a folder for each project you are
working on, for each of your clients, for each laboratory application,
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or for each sample type. See your Windows documentation for
information about creating directories. You can specify which
folder to use when you use Save or Save As in the File menu to save
spectra. This will make it easier to find a spectrum in a particular
category when you use Open in the File menu to open a spectrum.

In the OMNIC Help system Index, find “spectrum, saving” and go to
the “Saving spectra with a new filename” topic.

How can I save several spectra in one file as a group?

Select the spectra and then choose Save Group from the File menu.
To select more than one spectra, hold down the Control key and
click each spectrum you want to select with the selection tool, and
then release the Control key. Spectral groups are saved with the
extension .SPG.

In the OMNIC Help system Index, find “saving, spectra” and go to
the “Saving a group of spectra” topic.

How can I delete stored spectra?

Choose Delete Files from the File menu to display the Delete Files
dialog box. Locate and select the spectral data files (with the
extension .SPA, or .SPG for spectral group files) you want to delete
and then choose OK.

In the OMNIC Help system Index, find “deleting, spectra” and go to
the “Deleting files” topic.

Can I delete an entry from a report notebook?

No. OMNIC’s report notebooks are similar to traditional laboratory
notebooks in that information you add to them becomes part of the

permanent record of your work. You can delete an entire notebook,
however, by deleting the entire notebook file. Choose Delete Files
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from the File menu to display the Delete Files dialog box. Locate
and select the subdirectory containing the notebook data files (with
the extension .NBK). You will have to set the List Files Of Type
box to All (*.*) to see .NBK files listed. Select the file you want to
delete and then choose OK.

How can I specify a printer for printing information?

Use Printer Setup in the File menu. See your Windows
documentation for details on setting the printer parameters.

In the OMNIC Help system Index, find “printer” and go to the
“Setting up the printer” topic.

How can I create and print reports of my work?

Use the commands in the Report menu. First use Template to select,
edit or create a template for the report. Then use Preview/Print
Report to view the report as it will appear on paper. Click the Print
button to print the report.

In the OMNIC Help system Index, find “template” and go to the
“Selecting, editing or creating a report template” topic, or find
“report, previewing or printing” and go to the “Previewing or
printing a report” topic.

You can also use Add To Notebook to add the report to a report
notebook. You can then print the report with the Print button when
you view the notebook using View Notebook.

In the OMNIC Help system Index, find “adding, report to notebook”
and go to the “Adding a report to a notebook™ topic.
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How can I preview spectra or other information before
printing?

Use Preview/Print Report in the Report menu to view a report as it
would appear on paper. The report is displayed using the current
report template; that is, the template you have specified with
Template or the template you are viewing and working with. If the
report is displayed as you want it to appear on paper, you can print it
by using the Print button.

In the OMNIC Help system Index, find “template” and go to the
“Selecting, editing or creating a report template” topic, or find
“report, previewing or printing” and go to the “Previewing or
printing a report” topic.

How can I select more than one spectrum at a time?

Hold down the Control key while you click the spectrum. You can
also choose Select All from the Edit menu to select all the spectra in
the window that are not hidden.

In the OMNIC Help system Index, find “selecting, spectra’ and go
to the “Selection tool” topic or “Selecting all the spectra in a spectral
window” topic.

How can I specify colors for displaying spectra?

Choose Options from the Edit menu, click the View tab and then
choose Colors. In the Colors dialog box click the color next to the
spectrum number for which you want to specify the color and then
click the desired color in the color array. To specify the color for
selected spectra, click the color next to Selected Spectrum and then
click a color. Typically red is the color reserved for displaying
selected spectra.

In the OMNIC Help system Index, find “spectra, colors” and go to
the “Specifying colors for spectra and other features” topic.
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You can also specify colors for displaying spectra in a particular
spectral window. Start by selecting the spectra for which you want
to specify a color, and then choose Display Setup from the View
menu. Click the desired color in the color array and then choose
OK. When the spectra are no longer selected, such as after you
select a different spectrum, they will be displayed in the color you
clicked.

In the OMNIC Help system Index, find “spectra, colors” and go to
the “Selecting a color for the currently selected spectra” topic.

What is the difference between the Display Setup parameters
and the Window options?

The parameters in the Display Setup dialog box affect the currently
active spectral window only. The options in the Window options (in
the Options dialog box) affect all the new spectral windows that you
create. After you create a new spectral window, you can change the
way spectra are displayed in it by using Display Setup.

In the OMNIC Help system Index, find “display parameters” and go
to the “Setting the display parameters” topic, or find “Window
options” and go to the “Window options” topic.

What can I do with the “‘Scale’” commands in the View menu?

By using the appropriate command, you can display spectra so that
they are easier to see or compare.

Full Scale displays the spectra so that they perfectly fit their panes
vertically. Automatic Full Scale does this automatically when you
change the display with the view finder or selection tool. The

Y -axis displayed corresponds to the selected spectrum.
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Common Scale displays all the spectra so that they are not cut off at
the top or bottom and use the same Y scale. This allows you to
compare the band intensities of different spectra.

Match Scale changes the Y scale of the spectra to be the same as that
of the selected spectrum. (The selected spectrum’s scale is not
changed.) This allows you to compare the band intensities of
different spectra.

Offset Scale shifts the spectra vertically so that they overlap less,
making them easier to see.

When you use these commands, keep in mind that the current Y-axis
is always accurate for the currently selected spectrum but may not
apply to other spectra in the window.

In the OMNIC Help system Index...

e For information about Full Scale or Automatic Full Scale, find
“displaying, spectra” and go to the “Displaying spectra full
scale” topic or “Displaying spectra full scale automatically”
topic.

e For information about Common Scale, find “displaying, spectra”
and go to the “Displaying spectra using the same

Y-axis” topic.

e For information about Match Scale, find “displaying, spectra”
and go to the “Matching the Y scale of a spectrum” topic.

e For information about Offset Scale, find “displaying, spectra”
and go to the “Displaying spectra vertically offset” topic.
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How can I zoom in on an area of a spectrum?

Draw a box around the area using the selection tool and then click
inside the box.

You can also click the top half of the Expand/Contract button at the
&> | left end of the view finder or drag the regions markers in the view
finder to display a smaller spectral region.

In addition, you can use the Roll/Zoom window available in the
View menu (or click the Roll/Zoom window button in the toolbar if
displayed) to expand an area.

In the OMNIC Help system Index, find “expanding, spectrum” and
go to the “Selection tool” topic, “View finder” topic or “Rolling and
zooming spectra” topic.

How can I move a spectrum up or down in its pane to see it
better?

Use the selection tool to drag the spectrum up or down.

You can also use the Roll/Zoom window available in the View menu
to move a spectrum up or down.

In the OMNIC Help system Index, find “moving, spectrum” and go
to the “Selection tool” topic or “Rolling and zooming spectra” topic.

How can I move a spectrum into another spectral window?

——  Use the selection tool to drag the spectrum from one spectral

R window to another. A copy of the spectrum appears in the second
window, and the original spectrum remains in the first window. You
can also copy or cut the spectrum using Copy or Cut in the Edit
menu and then paste it into another spectral window using Paste.
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In the OMNIC Help system Index, find “moving, spectrum” and go
to the “Selection tool” topic, or find “pasting, spectrum” and go to
the “Pasting items” topic.

How can I move a stacked spectrum into another pane?

Use the selection tool to drag the spectrum from one pane into
another.

In the OMNIC Help system Index, find “moving, spectrum” and go
to the “Selection tool” topic.

How can I find the X and Y values of a point in a spectrum?

Use the spectral cursor tool to click the point. The values are
displayed in the readout above the palette.

In the OMNIC Help system Index, find “Displaying, X and Y
values” and go to the “Spectral cursor tool” topic.

How can I find the height of a peak?

Use the peak height tool to click the top of the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
The corrected (measured above the baseline) and uncorrected height
values appear in the readout above the palette.

In the OMNIC Help system Index, find “Peak, height” and go to the
“Peak height tool” topic.

How can I find the area of a peak?

Use the peak area tool to drag across the peak. Then drag the
baseline handles to adjust the baseline used for the measurement.
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The corrected (measured above the baseline) and uncorrected area
values appear in the readout above the palette.

In the OMNIC Help system Index, find “Peak, area” and go to the
“Peak area tool” topic.

Should I correct the baseline of my spectrum?

If a baseline is sloped or curved or significantly above zero
absorbance (or below 100% transmittance), a likely cause is how the
sample was prepared. By correcting the baseline, you can often
avoid having to prepare the sample again and collect a new
spectrum.

Correcting a baseline will give you better results when you search
the spectrum against a library, subtract the spectrum from another
spectrum, find peaks in the spectrum or quantify components in the
spectrum.

View the “Common Problems” unit of the “Collecting a Spectrum”
tutorial.

In the OMNIC Help system Index, find “correcting, baseline” and
go to the “Correcting a baseline manually” topic.

How can I subtract a spectrum from another spectrum?

Use Subtract in the Process menu whenever you want to subtract one
spectrum from another. Subtract is commonly used to remove
spectral features of solvent residues or pure components from the
spectrum of a mixture of compounds.

Select the spectrum from which you want to subtract spectral
features; this is the sample spectrum. Then hold down the Control
key and select the spectrum with the features you want to subtract
from the sample spectrum; this is the reference spectrum.
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Note

Subtract is available in the Process menu only when two spectra are
selected. a

Choose Subtract from the Process menu. The difference spectrum is
displayed full scale in the bottom pane. This spectrum is the result
of subtracting the reference spectrum from the sample spectrum
using the subtraction factor shown to the left of the result. If you are
not satisfied with the subtraction result, you can change the
subtraction factor.

In the OMNIC Help system Index, find “subtracting, spectra” and go
to the “Subtracting spectra” topic.

What should I use subtraction for?

Subtract is commonly used to remove spectral features of solvent
residues or pure components from the spectrum of a mixture of
compounds. When you use Subtract, the software calculates data
point by data point the difference between the two.

Spectral subtraction is useful in a variety of situations. Here are
some examples:

e Eliminating solvent peaks in a spectrum of a sample that is
dissolved in a solvent.

e Separating components from a sample that is a mixture of two or
more components.

e Identifying an unknown contaminant by subtracting out the
known sample material.

e Ensuring quality by subtracting an original batch sample
spectrum from a spectrum from the next batch.

What other arithmetic operations can I perform on my spectra?
You can manipulate your spectra using any of the common

arithmetic operations. Use Spectral Math in the Process menu to
perform these operations on one or two selected spectra. You
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specify the operations to perform by typing a sequence of
mathematical symbols and numbers. The software performs the
operations on the Y values of the data points in the spectrum or
spectra and then displays the result spectrum.

When you choose the command, the Spectral Math window appears
allowing you to type the desired operations in the Operation text
box. You can also select one of the example operations provided in
the Operation drop-down list box.

In the OMNIC Help system Index, find “spectrum” and click the
topic that corresponds to the operation you want to perform.

How can I customize my OMNIC software?

You can use Options in the Edit menu to set options that determine
how the software operates. You can also customize the menus and
the toolbar using Edit Menu and Edit Toolbar in the Edit menu. Use
Save Configuration As in the File menu to save your customized
settings in a configuration file. You can then open the file later to
reset OMNIC to your preferences in one step.

View the “Preparing the Software” unit of the “Collecting a
Spectrum” tutorial.

In the OMNIC Help system Index...

¢ Find “options” and go to the “Customizing OMNIC by setting
options” topic.

e Find “customizing, menu” and go to the “Customizing a menu”
topic.

e Find “customizing, toolbar” and go to the “Customizing a
toolbar” topic.

e Find “saving, configuration” and go to the “Saving a
configuration” topic.

o Find “opening, configuration” and go to the ‘Opening a
configuration” topic.
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Other questions

How can I find and label peaks in spectra?

Use Find Peaks in the Analyze menu to find and label peaks above a
specified threshold.

You can also use the annotation tool to label individual peaks.

In the OMNIC Help system Index, find “finding peaks™ and go to
the “Finding peaks above a specified height” topic, or find “labeling
peaks” and go to the “Annotation tool” topic.

How can I close a task window (such as the Find Peaks
window)?

Click the Close button (if available) in the upper-right corner of the
window or double-click the button at the left end of the window’s

title bar (if the window is not maximized) or the button at the left
end of the menu bar (if the window is maximized).

In the OMNIC Help system Index, find “closing, task window” and
go to the “Task windows” topic.

How can I select a spectral region for an operation?

Use the region tool to drag across the region in the pane.

In the OMNIC Help system Index, find “selecting, spectral region”
and go to the “Region tool” topic.
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How can I display information about how a spectrum was
collected and processed?

Select the spectrum and then click the Information button to the left
of the title box. You can also double-click the spectrum’s title in the
title box.

In the OMNIC Help system Index, find “collection and processing
information” and go to the “Collection and processing information”
topic.

If you want this kind of information displayed in a spectrum’s pane,
choose Display Setup from the View menu, turn on Sampling
Information and then specify the types of information you want
displayed by turning on options in the Sampling Information box.

In the OMNIC Help system Index, find “displaying, sampling
information” and go to the “Displaying sampling information” topic.

How can I copy a spectrum and paste it into a text document?

Select the spectrum and choose Copy from the Edit menu. This
places the spectrum on the Clipboard in the form of a Windows
metafile (this is the file format with the most flexibility for pasting
into other programs). You can then paste the spectrum into a
document by using a word processing program.

In the OMNIC Help system Index, find “copying, spectrum” and go
to the “Copying items” topic.
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A Warning

Note

Quick Answers to Your Questions
About Using the Spectrometer

This chapter presents common questions and answers about using
your spectrometer. Each question is followed by a brief answer,
plus a reference for where you can go for more information.

When do I need to remove the spectrometer cover?

You need to remove the spectrometer cover to change sources or
detectors. Also, you need to open the cover if you are installing a
spectrometer component such as a laser or electronics module.

See “Removing the cover” available through Replacing Parts in the
Help menu for instructions for removing the cover.

Do not operate the spectrometer with the main cover removed. The
cover protects you from exposure to laser light and live electrical
connections. If you must open the main cover for maintenance or
service reasons, always turn off the spectrometer power first. a

When should I align the spectrometer?

Align the spectrometer after you replace the laser or move the
spectrometer. It is also a good idea to align the spectrometer if the
signal intensity has dropped significantly from its usual level.

Turn on the spectrometer and leave it on for at least an hour before
you align it. This allows the spectrometer to reach thermal
equilibrium. a

View the “Testing Performance” unit of the “Collecting a Spectrum”

tutorial for information about when to align the spectrometer.
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In the OMNIC Help system Index, find “aligning, spectrometer” and
go to the “Aligning the spectrometer” topic for information about
performing an automatic alignment.

Does my detector need to be cooled with liquid nitrogen?

Most detectors (including the standard DTGS detector) do not need
to be cooled. Detectors that have a dewar need to be cooled. Dewar
detectors are insulated metal cylinders with a hole in the top. These
include MCT detectors.

If during a work session you find that the signal intensity from your
cooled detector is decreasing, it may need to be refilled with liquid
nitrogen.

When should I change the desiccant?

When the desiccant indicator at the rear of the sample compartment
turns light purple, change the desiccant cartridge. Do not discard the
spent cartridge. It can be baked out, stored in a desiccator, and used
the next time you need to change the cartridge.

You should check the indicator every two months, more often if
your laboratory is not air conditioned.

Choose Replacing Parts from the OMNIC Help menu and view the
“Changing desiccant” tutorial in the “Replacing parts” book for
information about changing and regenerating desiccant cartridges.

Which source should I use?

Use the source that is appropriate for the spectral range of your
experiment (determined by the ranges of the beamsplitter and
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Note

detector). Nicolet offers a mid-IR source (Ever-Glo) and a near-IR
source (white light).

In the OMNIC Help system Index, find “source” and go to the
“Specifying the source type” topic for information about setting the
Source parameter.

See “Selecting the right beamsplitter and detector” in the “Using
beamsplitters and detectors” section of the “Spectrometer Basics”
chapter of this manual for a table showing the compatibility of
sources, beamsplitters and detectors.

Should I turn off the spectrometer when I’m not using it?

We recommend that you leave the spectrometer on. This improves
the thermal stability of the system and gives you more consistent
results when you collect spectra.

How can I diagnose problems with the spectrometer?

The performance of the spectrometer is monitored while you collect
spectra. If a problem occurs, a troubleshooting message is displayed
on your screen.

See the troubleshooting information available in the Help menu for
instructions on diagnosing spectrometer problems, ordering parts
and replacing parts.

If you wish to view the on-line videos to help you in troubleshooting
a problem, put the Spectrometers Tutorials CD in the computer. a

You can also make a more thorough check on a spectrometer
component by choosing Advanced Diagnostics from the Collect
menu. This starts the Bench Diagnostics program, which provides
information about the status of the component as well as
troubleshooting information, replacement procedures and
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information about ordering replacement parts. See the “Service and
Maintenance” chapter of this manual for more information.

In the OMNIC Help system Index, find “diagnostics” and go to the
“Checking bench components” topic.

Do I need to use an energy screen with my detector?

In most cases, no. If you are using a highly sensitive detector such
as a PbSe or MCT-A detector and your experiment deals with
information from a broad range of frequencies, use an energy screen
to prevent the detector from becoming saturated or producing a
distorted signal.

See “Setting up for experiments” available through Installing
Hardware in the Help menu for information about installing energy
screens.

Do I need to use a bandwidth-limiting filter?

In most cases, no. If you are using a highly sensitive detector such
as a PbSe or MCT-A detector and your experiment deals with
information in a narrow range of frequencies, a bandwidth-limiting
filter can prevent the detector from becoming saturated or producing
a distorted signal. Bandwidth-limiting filters improve the signal-to-
noise ratio of the data and also prevent detector saturation by
allowing only energy in your particular area of interest to pass to the
detector element. If you wish to use a bandwidth-limiting filter, you
must supply your own.

See “Setting up for experiments” available through Installing
Hardware in the Help menu for instructions for installing filters.
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A Warning

Running
diagnostic tests

Service and Maintenance

This chapter describes service and maintenance routines that you can
perform on the spectrometer. We define service as a procedure to
replace a failing part in the spectrometer. We define maintenance as
an occasional procedure you perform to keep the spectrometer
running efficiently.

Perform only those routines described in this chapter. If there are
other problems, contact Nicolet at one of the numbers below.
Outside the U.S.A. call your local sales or service representative.
Telephone numbers for all Nicolet Customer Support offices are
provided with your system.

e Telephone (U.S.A.): 1-800-NICOLET (1-800-642-6538)
e Fax: 1-608-273-6045

o World Wide Web:  http://www.nicolet.com

e E-mail: nicinfo@nicolet.com a

See the troubleshooting information available in the Help menu for
instructions on diagnosing spectrometer problems, ordering parts
and replacing parts.

If your system is not performing properly, you can use the
Diagnostic tab in the Experiment Setup dialog box to check the
performance of spectrometer components. You should run these
diagnostic tests if you have problems with your spectrometer to
determine the source of the problem.
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To run the spectrometer diagnostic tests:

1.

Make sure the main sample compartment is empty.

Remove any samples and sampling accessories.

Choose Experiment Setup from the toolbar or the Collect
menu.

Click the Diagnostic tab.

The Diagnostic tab appears showing icons for the major
components of the spectrometer with a live display of the signal
from the detector.

To see information about a component, click that
component’s indicator icon.

When you click one of the indicators, a dialog box appears
showing information about the status of the component. If the
operating values for the component are within proper limits, a
check mark appears in the Status column. If the value is outside
the acceptable range, an X appears in the Status column.

When you are finished viewing the information, choose OK.
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Maintenance

Several spectrometer components—including the detector, light
source, the laser module, electronics module and the power supply—
were designed so you can replace them yourself if they fail.

The diagnostics software will alert you to failing components. See
the troubleshooting information available in the Help menu for
instructions on diagnosing spectrometer problems, ordering parts
and replacing parts. a

If the source, laser module, electronics module or power supply
must be replaced, refer to the replacement parts list available
through Replacing Parts in the Help menu. Call 1-800-NICOLET
(1-800-642-6538) or 1-608-276-6373 to order the replacement
assembly. If you are outside the U.S., contact your local Nicolet
office. Telephone numbers for all Nicolet Customer Support offices
are provided with the documentation with your spectrometer.

The rest of this chapter describes how to use the OMNIC software to
align the spectrometer and accessories, and run performance tests.

Instructions for other common maintenance procedures, such as
changing desiccant, cleaning the purge filter and cleaning the outside
of the spectrometer, are available on-line. Choose the “Maintaining
your spectrometer” book available through Replacing Parts in the
Help menu.
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Aﬁgning To ensure optimum system performance (high signal intensity, low
the spectrometer noise and good sensitivity), you should occasionally align the

Note If you have just turned on or moved the spectrometer, wait
15 minutes (one hour for best results) before you align it so the
spectrometer will have time to stabilize. a
Follow these steps:
1. Remove any sample or accessory from the spectrometer.
The beam path must be clear during alignment.

2. Choose Experiment Setup from the toolbar or the Collect
menu. ’

The Experiment Setup dialog box appears.

3. Make sure Sample Compartment on the Bench tab is set to
Main.

4. Set Gain on the Bench tab to 1.

Do not use Autogain.

An interferogram is shown in the live display. In the OMNIC Help
system Index, find “experiment” and go to the “Using Experiment
Setup” topic for more information.

If you want to view a single-beam spectrum instead, turn on the
Single Beam check box on the Bench tab.

If you want to hear a tone whose pitch indicates the signal
intensity, turn on the Tone check box on the Bench tab. The
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Aligning an accessory

tone reaches its highest pitch when the signal is maximized.

5. To perform an alignment, click the Align button on the
Diagnostic tab.

When you click the Align button, the system begins to optimize
the IR signal for maximum energy throughput. Alignment
should take 2 to 4 minutes.

The live display of the detector signal changes as each
interferogram is collected. The highest and lowest signal
intensities are shown next to Max and Min above the live
display. The interferogram location is shown next to Location,
unless you turned on Single Beam.

6. When the alignment is finished, close the Experiment Setup
dialog box. :

You can also align accessories that mount inside a sample
compartment. (This does not include Smart accessories, which do
not require alignment.) First align the spectrometer, as described in
the preceding section. Then set Sample Compartment on the Bench
tab of the Experiment Setup dialog box according to the accessory
location. Set Gain to a value that gives a signal intensity that is
appropriate for the accessory. ATR and diffuse reflection
accessories typically use a Gain setting of 2 or 4.

If you are not satisfied with the signal intensity after alignment, you
can manually align most accessories to maximize the signal. For
complete instructions, see the manual that came with the accessory.

When you manually adjust an accessory, watch the largest

interferogram peak. The larger this peak, the better is the signal
intensity.
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Note  The largest interferogram peak can be positive or negative. a

If you are unable to see the display, turn on Tone before adjusting
the accessory. The tone reaches its highest pitch when the signal is
maximized.

Performance test The performance test can be used to track long-term spectrometer
performance. Run it after you have installed the system and then
weekly. Keep arecord of the actual values obtained. When you run
the test, the software measures the response of the spectrometer
optics and atmospheric absorptions in the spectrometer and then
collects a “sample” spectrum with no sample in place. The result is
a “100% line,” a display of system noise that appears as a generally
flat line at 100% transmittance.

Follow these steps to conduct a performance test:

1. Make sure the main sample compartment is empty.

Remove any samples and sampling accessories.

2. Exit OMNIC to ensure that the Bench Diagnostics software
runs correctly.

3. Start the Bench Diagnostics software.

Click the Start button, then the Programs icon and then the
OMNIC E.S.P. folder. Choose Bench Diagnostics.

For more information about running the Bench Diagnostics
programs, see the “Bench Diagnostics” section in the
“Troubleshooting Hardware Problems” chapter of this manual.

Nicolet
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Note

Checking the purge

A Caution

A Warning

4. Follow the directions that appear on the screen to run the
performance test.

Click the Performance Tests button and conduct the test as
instructed by the software.

If the noise readings are greater than normal or have changed
significantly, align the spectrometer and check the purge or
desiccant. A gradual increase in noise as the spectrometer ages is
normal. If the noise level suddenly increases to twice its normal
level or higher, a component may be defective; call the Nicolet
Customer Support Department for assistance. Outside the U.S.A.,
call your local service representative. Telephone numbers for all
Nicolet Customer Support offices are provided with OMNIC Help. a

If special performance tests are available for your spectrometer,
a button labeled “Extended Tests” (or another appropriate name)
will appear. Click this button and follow the instructions that
appear on the screen to perform the tests.

If your spectrometer is equipped with an optional purge kit, make
sure the pressure regulator is set between 10 and 20 pounds per
square inch (psi) and the flowmeter is set to 15 standard cubic feet
per hour (scfh).

Excessive purge flow rates can introduce noise into your spectra.
Do not exceed 15 scfth. a

Never use a flammable gas to purge the spectrometer. The purge
gas must be free of moisture, oil, carbon dioxide and other reactive
or infrared-absorbing materials. We recommend using dry air or
nitrogen. Using other gases to purge your spectrometer, including
inert gases such as argon (AR), can damage your spectrometer. a

We recommend that you leave the purge on at all times. This keeps

the spectrometer free of undesirable gases, protects the optics and
improves the system’s thermal stability.
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Choose Installing Hardware from the OMNIC Help menu and view
the tutorials in the “Maintaining your spectrometer” book for
information about how to install the purge equipment, set the
controls for the first time, and inspect and clean the purge filter.

Standard DTGS detectors do not need cooling. Some optional
detectors, such as an MCT detector, require cooling with liquid
nitrogen.

Choose Installing Hardware from the OMNIC Help menu and view
the “Cooling a detector” tutorial in the “Installing hardware” book
for information about how to cool an MCT detector.

Liquid nitrogen is extremely cold and therefore potentially
hazardous. Avoid contact with skin. Wear protective clothing and
follow standard laboratory safety practices to prevent injury. a

After you fill the detector dewar with liquid nitrogen, allow the
detector to cool at least 20 minutes before collecting spectra.
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Troubleshooting Software Problems

OMNIC E.S.P. automatically and continuously checks the status of
your system. If a problem is found, a message automatically appears
allowing access to more information. This chapter lists some simple
troubleshooting measures you can take to solve software problems
with OMNIC E.S.P. For more information about troubleshooting,
consult the OMNIC on-line Help system.

What hardware and software do I need?

For optimum performance we recommend that your system have, at
a minimum, the following items:

Intel® Pentium® processor with 100 MHz or greater clock speed.
At least 16 megabytes of random access memory (RAM).
The capability of displaying at least 256 colors.
Hard disk size of at least 1.0 gigabyte.
Quad speed CD-ROM drive.
A 1.44-megabyte floppy disk drive for 3.5-inch floppy disks.
A 15-inch SVGA monitor with 800 by 600 resolution.
A keyboard and serial, bus, or PS/2®-style mouse.
A 16-bit Sound Blaster-compatible sound card.
Two serial ports (if you plan to use a Plus™ 2 liquid analysis
system).
Two ECP bidirectional parallel ports.
Three ISA/PCI slots.
e For OMNIC version 5.0 or greater
Windows 95, Windows 98, or Windows NT version 4.0 or
greater.
For OMNIC version 4.xx
Windows 95, Windows 98, or Windows NT version 3.51 or
greater
(NT systems can be used for workstations only).
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Problem

Possible Cause

Solution

After data collection a
message says the
sample and
background spectra
have the wrong
resolution.

The resolution of the current
background spectrum does not
match the resolution selected
for the sample spectrum
collection.

Change the Resolution to match the

background and collect the spectrum again.

Use the Resolution parameter on the
Collect tab of the Experiment Setup dialog
box.

The Quantify
command is dimmed.

No quantitative analysis
method is selected.

No spectrum is selected.
The quantitative analysis

method is not appropriate for
the selected spectrum.

Select the quantitative analysis method
using Quant Setup in the Analyze menu.

Select a single spectrum.

Select an appropriate method for the
selected spectrum.

OMNIC needs to be
restored after a system
crash or a message
states that OMNIC
cannot start or will no
longer run.

There is not enough memory.

There is another system
problem.

Make sure OMNIC has enough memory.
Quit other programs to free memory for
OMNIC.

Restart Windows.

Run the SCANDISK utility included with
your Windows software.

Restart OMNIC. If OMNIC does not start,
reinstall OMNIC.

Libraries created with
a previous version of

The libraries are not in one of
the directories listed in the

Use the Add Directory button on the
Search Libraries tab to add the

OMNIC are not listed | dialog box (typically OMNIC\SEARCH44 directory and any
in the Library Setup OMNIC\LIBS). other directories you are using to store
dialog box. libraries.
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Problem

Possible Cause

Solution

You cannot add a
spectrum to a user

library.

The resolution of the spectrum
is lower (higher numerical
value) than that of the library.

The spectral range of the
spectrum does not match the
spectral range of the library.

The spectrum is a
commercially collected
reference spectrum.

Collect the spectrum at the same resolution
as the library (first set Resolution on the
Collect tab of the Experiment Setup dialog
box), and then add it to the library.

Collect the spectrum at the same spectral
range as the library (first set Spectral
Range Saved on the Bench tab of the
Experiment Setup dialog box) and then add
it to the library.

Only spectrum you collect can be added to
a user library. Commercial libraries cannot
be altered and the spectra contained in
them cannot be copied to other libraries.

An experiment
provided with OMNIC
does not produce good
results.

The parameter settings in the
experiment file have been
changed so that the experiment
is not longer useful.

Restore the experiment to its default
settings: First open the experiment using
Experiment Setup and save it using a new
filename if you do not want to overwrite it.
Then open the experiment in the
FACTORY directory whose filename is the
same as the original experiment and save it
in the OMNIC\PARAM directory.

The desired
experiment does not
appear in the
Experiment drop-
down list box.

The experiment was installed
with the software but has not
yet been opened.

If the experiment was designed for a Smart
accessory, install the accessory; the
experiment will be opened automatically
and will appear in the Experiment drop-
down list box. If the experiment was not
designed for a Smart accessory, open it
using Experiment Setup; it will be added to
the list.
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Troubleshooting Hardware Problems

OMNIC continuously monitors the operation and status of your
spectrometer and informs you if a problem is found. The Bench
Status indicator below the menu bar shows the status of the
spectrometer operation. When OMNIC performs a check and
detects a problem, the Bench Status indicator is displayed as a
yellow circle or a red X along with an message alerting you to the
problem.

This chapter lists some simple troubleshooting measures you can
take to solve problems with the spectrometer. The Bench
Diagnostics program is described at the end of the chapter. If your
actions do not solve the problem, call your Nicolet service office.

Note For more information about troubleshooting, use Troubleshooting in
the OMNIC Help menu. a
A Warning  Always follow the safety precautions included in this manual and in
your Spectrometer Safety Guide when performing any of the
following troubleshooting procedures. a
Problem Possible Cause Solution
There is frost on the The insulating vacuum If you suspect that your detector has a
outside of a cooled chamber surrounding the vacuum leak, choose Troubleshooting from
detector. dewar has begun to leak. the OMNIC Help menu and choose the
MCT detector is warm topic from the
General Troubleshooting help book.
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Problem

Possible Cause

Solution

The indicators on the
front panel do not light
when the spectrometer
is turned on.

The power supply connection
on the back of the
spectrometer is loose.

The spectrometer is not
plugged in.

The power cord is not properly
rated for your electrical
service.

The ground prong on the
power cord has been removed
or is defective.

The power cable or power
supply is defective.

Turn off the spectrometer and check the
connections between the spectrometer and
the power supply. Make sure that the lock
ring is tightened finger-tight.

Make sure that the power cord is securely
connected to the power supply and a
working outlet or power strip.

Make sure that the power cord is
appropriate for your AC power source.
Choose Replacing Parts from the OMNIC
Help menu for power cord descriptions and
part number information.

Replace the power cord. Choose Replacing
Parts from the OMNIC Help menu for
power cord descriptions and part number
information.

Check the three power LEDs (next to the
power connector on the rear panel). All the
LEDs light when the power supply is
working properly. If necessary, Replace
the power supply.

Call Nicolet to order a replacement part.
Choose Replacing Parts from the OMNIC
Help menu for part number information.
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Problem

Possible Cause

Solution

Data is not displayed

during data collection.

The data cable between the
spectrometer and computer is
not properly connected.

The spectrometer is out of
alignment.

The laser is not functioning.

Turn the spectrometer power off and check
the data cable connections.

Align the spectrometer. Use the Align
button on the Diagnostic tab of the
Experiment Setup dialog box.

Check the laser indicator on the Diagnostic
tab in Experiment Setup. Replace the
laser if necessary.

The Scan indicator
does not flash.

The spectrometer is turned off.

Spectroscopy software has not
been started.

No data has been collected for
an hour or more and the
spectrometer is in “stand-by”
mode.

The spectrometer is out of

alignment.

The electronics module needs
to be reset.

Turn on the spectrometer.

Double-click the OMNIC or EZ OMNIC
shortcut to start the software.

This is normal. The system will begin
scanning when you use OMNIC to collect
background or sample data.

Align the spectrometer. Use the Align
button on the Diagnostic tab in the
Experiment Setup dialog box.

Turn off the power to the computer and the
spectrometer. Leave the power off for 15
seconds. Turn on the spectrometer and
wait until the power-up diagnostics finish.
Then turn on the computer and restart
OMNIC.

Avatar 360 System User’s Guide 95

Artisan Technology Group - Quality Instrumentation ... Guaranteed | (888) 88-SOURCE | www.artisantg.com




Problem Possible Cause Solution

An error message The light source is not Check the source indicator on the
appears when you try | working. Diagnostics tab in Experiment setup. If
to scan. necessary replace the source.

An optional cooled detector is

not cooled.

The interferogram is not

located at 1024 +16 data points

on the Bench tab in the

Experiment Setup dialog box.
The beam path is blocked.

The data cable between the
spectrometer and computer is

not properly connected.

If you are using an optional cooled
detector, check and cool the detector.

Align the spectrometer. If the
interferogram is still not located correctly,
call Nicolet for service.

Remove the obstruction.

Turn off the spectrometer power and check
the data cable connections. Also make sure
that the parallel port is in ECP mode.

The signal intensity is
low in the mid-IR
range.

The optional automated

aperture is set incorrectly.

The source is glowing
unevenly.

Check the Aperture parameter on the

Bench tab in the Experiment Setup dialog
box. For DTGS detectors set the aperture
to 100; for MCT-A detectors, set it to 10.

Check the source indicator on the
Diagnostic tab in the Experiment Setup
dialog box. Order a replacement if needed.

The signal intensity is
low, there are frequent
interferometer scan
restarts (verified by
intermittent flashing of
the Scan indicator) and
the spectrometer
alignment fails.

The spectrometer is out of

alignment.

The beamsplitter is fogged.

Align the spectrometer. Use the Align
button on the Diagnostic tab in the
Experiment Setup dialog box.

Check the laser signals by clicking the laser
indicator on the Diagnostic tab in the
Experiment Setup dialog box. If you
suspect the beamsplitter is fogged, call
Nicolet for service.
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Problem

Possible Cause

Solution

The system scans but
gives a very low signal
intensity.

The spectrometer is out of
alignment.

The moving mirror velocity is
set too high.

There is no interferogram.

The optional automated
aperture is set incorrectly.

A non-Avatar sampling
accessory is not aligned.

Align the spectrometer. Use the Align
button on the Diagnostic tab in the
Experiment Setup dialog box.

For DTGS detectors, reduce the velocity
parameter on the Bench tab in the
Experiment Setup dialog to 0.63 or less.

Click the source indicator on the Diagnostic
tab in the Experiment Setup dialog box to
check the source current and voltage. If the
source indicator is on, check the
interferogram on the Bench tab in the
Experiment Setup dialog box; if the
interferogram is not present, check the beam
path and detector.

Check the Aperture parameter on the Bench
tab in the Experiment Setup dialog box.
For an MCT-A detector, set Aperture to 10.
For a DTGS detector, set Aperture to 100.

Align the accessory. Use the instructions
that were included with the accessory.

The baseline is not
stable.

The purge rate is too high.

The spectrometer is out of
alignment.

The spectrometer cover was
recently opened.

Lower the purge rate until the baseline is
stable. The flowmeter should be set to
15 scth.

Align the spectrometer. Use the Align
button on the Diagnostic tab in the
Experiment Setup dialog box.

Allow the spectrometer to purge for 3 to 5
minutes after the cover is closed.
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Problem Possible Cause Solution

Unable to collect data | The printer is using the parallel | Wait until the printer is finished and then

message appears when | port for printing. begin your data collection. The

you start OMNIC. spectrometer cannot collect data while the
printer is printing.

The spectrometer is turned off. | Turn on the spectrometer and wait until the
power-up diagnostics finish before
restarting OMNIC.

The data cable is loose, Shut down the computer and turn the

disconnected, or damaged. spectrometer off. Check the data cable. If
it is damaged, replace it. If the cable is
loose or disconnected, reconnect it. Turn
on the spectrometer and wait until the
spectrometer power-up diagnostics finish.
Then turn on the computer and restart
OMNIC.

The parallel port in the Make sure that the computer parallel port is

computer is not configured in ECP mode. Use the instructions that

correctly. came with your computer.

A component has failed Contact Nicolet for service.
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Problem

Possible Cause

Solution

The spectrometer
temperature is out of
specification

The vents on the back of the
spectrometer are blocked.

There is not enough clearance
above the spectrometer.

The ambient temperature in
your lab may be too high.

A component failed.

Check the cooling vents. Remove any
obstructions. Always maintain 30 cm (12
in) of clearance behind the spectrometer.

Remove any items stacked on the
spectrometer. Always maintain 45 cm (18

in ) of clearance above the spectrometer.

The ambient temperature should be
between 16° and 27°C (60° and 80°F).

Contact Nicolet for service.

The laser is off.

The laser cable is not seated
properly.

The laser or the electronics
module is defective.

Turn off the spectrometer and then remove
the spectrometer cover to check the cable.
See Troubleshooting in the OMNIC Help
menu for instructions.

Check the laser status on the Diagnostic tab
in theExperiment Setup dialog box. If there
is a slash through the laser indicator, click
the indicator.

If the laser frequency is outside the
specified range, replace the electronics
module. Choose Replacing Parts from the
OMNIC Help menu and use the “Replacing
the electronics module” tutorial to find the
part number, ordering and installation
instructions.

If the laser voltage or current are outside the
specified range, replace the laser. Choose
Replacing Parts from the OMNIC Help
menu and use the “Replacing the laser”
tutorial to find the part number, ordering
and installation instructions.
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Bench Diagnostics You can use the Bench Diagnostics program to perform diagnostic
tests on the main components of the spectrometer. You should run
these diagnostic tests if you have problems with your spectrometer
to determine the source of the problem. The diagnostics provide
information about the status of the component as well as
troubleshooting information, replacement procedures and
information about ordering replacement parts.

You can use the Bench Diagnostics program to:

Run the spectrometer performance test.

Test specific components of your spectrometer.
Get information about replacement parts.
Check the spectrometer configuration.

Get troubleshooting tips.

Follow these steps to run the Bench Diagnostics:

1. Make sure the main sample compartment is empty.

Remove any samples and sampling accessories.

2. Start the Bench Diagnostics software.

Choose Advanced Diagnostics from the Collect menu, or click
the Start button, and then choose the Bench Diagnostics icon in
the OMNIC E.S.P. folder. Some of the advanced features of the
program, including the Performance Test, are not available if
you run the diagnostics from OMNIC.
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3. Follow the directions that appear on the screen to run the
diagnostics.

When you are finished viewing information in a window, you
can use the navigation buttons to return to earlier windows.

Click this button to return to the previous window.

Click this button to return to the main Diagnostics window.

Exit the program by clicking the Close button at the far-right end
of the title bar.
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Declaration of Conformity

Model:  Avatar 360

This product complies with the following European Union Directives:

Electromagnetic Compatibility, 89/336/EEC as amended by 92/31/EEC and 92/68/EEC
Low Voltage, 73/23/EEC as amended by 92/68/EEC

The following standards were used to verify compliance with the Directives:

EN 50082-1: 1992, EN 50081-1: 1992, EN 55011: 1991, IEC 801-2: 1991, IEC 801-3: 1984,
IEC 801-4: 1988, EN 61010-1: 1993, EN 60825: 1992

EU Notified Body: ) Not Applicable Date
Approved by: Date
VP Operations
Thermo Nicolet Corporation
5225 Verona Road

ISO 9001/EN ISO 9001:1987

P.0. Box 44451 Thermo Nicolet certified by KEMA

Madison, WI 53744 - 4451

269-086300
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Troubleshooting Applications Problems

Your OMNIC software automatically checks the status of collected
interferograms and background and sample spectra. When OMNIC
performs a check and detects a problem with data collection or
spectra, the Collect Status indicator is displayed as a yellow circle or
ared X. You can click the indicator (or click the View Collect
Status button at the end of data collection) to see a summary of data
collection problems encountered during the collection and other
information about the collection.

This chapter lists some simple troubleshooting measures you can
take to solve data collection problems with the spectrometer. If the
action does not solve the problem, call your Nicolet service office.

Note  For more information about troubleshooting, consult the OMNIC
on-line Help system. a

Problem Possible Cause Solution

A spectrum contains The sample in a transmission | Use a thinner sample.

totally absorbing experiment is too thick.

| peaks.

A spectrum contains Your sample has parallel, Create a new film using a matte press.

fringes or channeling. | highly reflective sides that
cause the infrared beam to Try roughening the film surface slightly
bounce within the sample with silicon carbide paper or another
when the sample is placed suitable abrasive.
perpendicular to the infrared
beam. Rotate the sample so that the infrared beam

passes through the sample at Brewster’s
angle. This method should not be used if
you are performing a quantitative analysis
of the sample.
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Problem

Possible Cause

Solution

A spectrum contains
carbon dioxide peaks
that interfere with your
data.

The background spectrum is
too old.

The spectrometer is not
adequately purged.

The spectrometer is not purged
at all.

The spectrometer is purged but
your air drier does not remove
carbon dioxide.

Collect a new background spectrum to use
for ratioing your sample spectra.

If you have an optional purge kit, make
sure you are using dried air or nitrogen and
that the purge flow rate is set to 15 scth.
Allow the system 3 to 5 minutes to
reestablish purge before collecting a
spectrum.

If you do not have a purge sytem and the
carbon dioxide peaks interfere with your
data, you may want to install a purge gas
source and optional purge kit. Contact
Nicolet for details.

Replace the air drier with a model that
removes carbon dioxide. Contact Nicolet
for details.

There are no peaks in

There is no sample in the path

Check the sample compartment or

a spectrum. of the infrared beam. accessory to make sure the sample is
properly positioned in the beam path.

The sample cup in the slide of | Make sure the cup is properly positioned in
a diffuse reflection accessory | the accessory.
is not in place or is tilted.
The infrared microscope is in | Put the microscope in infrared mode and
its viewing mode. collect the spectrum again.
The sample film in an Make sure the sample is held evenly and
attenuated total reflection has good contact with the crystal.
(ATR) experiment is being
held against the ATR crystal
with uneven pressure or has
poor contact with the crystal.
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Problem Possible Cause Solution
A spectrum contains The desiccant has expired. Check the desiccant and replace it if
water peaks that necessary.

interfere with your
data.

The spectrometer is not
adequately purged.

Make sure you are using dried air or
nitrogen purge gas and that the purge flow
rate is set tol5 scfh. Allow the system 3 to
5 minutes to reestablish purge before
collecting a spectrum.

A spectrum contains
derivative-shaped
peaks.

A sample in a diffuse
reflection experiment also has
a specular reflection
component.

The infrared beam was
reflected from (instead of
penetrating) a flat, shiny
sample measured using a
specular reflection accessory.

Correct the spectrum by using Other
Corrections in the Process menu. (Select
Kramers-Kronig.)

Try using a less reflective sample.

The baseline of a
spectrum is not flat.

A KBr pellet was made with
coarsely ground KBr powder,
or the KBr pellet was
improperly pressed.

The background spectrum for a
cast film was collected with an
empty sample holder.

The spectrometer is not
properly aligned, causing a
sloped baseline.

The spectrometer has not
reached thermal equilibrium.

The spectrometer is not
properly purged.

Be sure to press the pellet properly.

Remove the sample holder and collect the
background again.

Use the Align button on the Diagnostic tab
in the Experiment Setup dialog box to align
the spectrometer.

For best results allow the spectrometer at
least 1 hour to stabilize after turning it on.

Check the system to make sure that the
correct purge gas is being used and that the
flow rate is set to 15 scth.
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Problem

Possible Cause

Solution

A spectrum is too

noisy.

There were too few scans.

The resolution was too high.

The purge gas flow rate or
pressure is too high.

The moving mirror velocity is
set too high for the detector.

If this an ATR experiment, the
sample is not in good contact
with the ATR crystal.

Increase the number of scans on the Collect
tab in the Experiment Setup dialog box.

Reduce the resolution on the Collect tab in
the Experiment Setup dialog box.

Check the pressure regulator; it should be
set between 10 and 20 psi. Check the
flowmeter; it should be set to 15 scth.

For DTGS detectors, reduce the Velocity
parameter setting on the Bench tab in the
Experiment Setup dialog box to 0.63 or
less.

Reapply the sample to obtain more
consistent contact between the sample and
ATR crystal.
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index

a
absorbance, 27, 58
accessories, 49

aligning, 50, 85

installing, 7, 50, 53

system, 53

turning on, 39
accessory

not aligned, 97
air dryer, 53
aligning

accessories, 50, 85

spectrometer, 77, 84
alignment failed, 96
annotation tool, 29, 75
aperture

automated, 53

set incorrectly, 96, 97
area of peak, 71
arithmetic operations, 73
ATR correction, 60
attenuated total reflection, 60
attenuated total reflection accessory, 49, 50
automated aperture, 53

b

Background checks, 58
background interferogram, 46
background spectrum
collecting, 15, 18
described, 15
sample spectrum ratioed against, 15
when to collect, 15
bandwidth-limiting filter, 47, 80

base name for saving spectra, 64
baseline
correcting, 59, 72
not flat, 105
peak, 71
unstable, 97
baseplate
installing, 16
beam path, 38
blocked, 96
beamsplitter, 43
fogged, 96
KBr, 15
spectral range, 44
Bench Status indicator, 6, 93

blanking, 60
button

toolbar, 6
C

cable loose, 95, 96, 99
carbon dioxide, 20, 104

correcting spectrum for, 61
channeling, 103
cleaning spectrometer, 83
closing task window, 75
Collect Status indicator, 23, 58, 103
collecting

background spectrum, 15, 18

sample spectrum, 16

spectra, 14

spectrum, 55

spectrum to be added to user library, 62
collection and processing information, 76
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colors

for displaying spectra, 67
commands of OMNIC, 5, 6
commercial spectra

restrictions, 33
compact disk, 8
compare

QGC, 31
component

subtracting, 73
compound name, 62
compound types, 31
computer

turning on, 40
configuration file, 74
connectors, 39
Contents tab of Help system, 9
converting spectrum to other units, 27, 58
cooling detector, 14, 78, 88
correcting

baseline, 59, 72

spectrum, 59
cover of spectrometer, 77
cover opened, 97

d

data collection, 55
preparing for, 14
deleting
label, 30
report notebook, 65
spectra, 65
derivative-shaped peaks, 105
desiccant, 8
changing, 78, 83
indicator, 78
detector, 43
bandwidth-limiting filter, 80
cooling, 14, 78, 88
DTGS, 15, 45
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detector, continued
energy screen, 80
frosted, 93
not cooled, 96
saturation, 46, 47, 80
sensitivity of affected by velocity, 48
signal distortion, 46, 47, 80
signal intensity, 78
signal intensity affected by gain, 56
spectral range, 44
spectral range affected by, 48
dewar, 78
vacuum leaking, 93
diagnostics, 54, 79, 81, 100
diffuse reflection, 60
diffuse reflection accessory, 50
directory
library, 90
Display Setup, 68
displaying
collection and processing information for spectrum,
76
library spectrum in spectral window, 62
peak area, 71
peak height, 71
spectra, 5, 67
* spectra full scale, 68
spectra with matched scale, 69
spectra with offset scale, 69
spectra with same Y scale, 69
X and Y values of point in spectrum, 71
documentation, 6
DTGS detector, 15, 45
velocity for, 48

e

E.S.P. system, 49

editing peak label, 30

electronics module, 95
replacing, 83
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e-mail, 2, 8
energy screen, 47, 80

signal-to-noise ratio increased by, 45
error during data collection, 96
Ever-Glo source, 15, 79
experiment

not listed, 91

restoring, 91

selecting, 5, 6, 14, 16
Experiment drop-down list box, 5, 6, 14, 16, 55
Experiment Setup, S, 6, 14, 17, 55
experiments, 5, 6, 14, 16, 55
extended search, 62
external beam, 51, 53

f

F1 function key, 9
fax numbers, 2, 8
filename
spectrum, 25
filter
bandwidth-limiting, 47
purge, 8, 14, 83
final format, 56
finding peaks, 75
flowmeter, 87
folders for saving spectra, 64
fringes, 103
front panel
indicators not lit, 94
frost on detector, 93
FT-IR
learning about, 7

8

gain, 56
gas cells, 51
Gemini, 51

group
saving spectra as, 65

h

hardware requirements, 89
height of peak, 71

Help system, 9

humidity indicator, 14

1
infrared beam, 38
infrared energy
transmitted by energy screens, 47
installing
accessories, 7, 50, 53
OMNIC, 3
optional hardware, 7
sample compartment baseplate, 16
sample holder, 16
spectrometer, 7
interferogram, 46
absent, 97
not located correctly, 96
Interferogram checks, 58
interferograms
saving, 57, 64
TUPAC, 44

k

KBr beamsplitter, 15

KBr pellet problems, 105
Kramers-Kronig transformation, 60
Kubelka-Munk units, 58
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1

label
deleting, 30
editing, 30
labeling
peak, 29
peaks, 75
laser
not working, 95, 99
replacing, 77, 83
Laser indicator
off, 99
library
adding spectra to, 64
adding to, 33
collecting and adding spectrum to, 62
creating, 32, 61
directory, 90
not listed, 90
QC, 31
scrapbook, 32
searching, 31, 59
searching for compound name, 62
searching for text, 62
spectrum cannot be added to, 91
types, 30
Library Manager, 32
library search
selecting spectral region for, 61
setting up, 59
library spectrum
displaying in spectral window, 62

finding by searching for compound name, 62

finding by searching for text, 62
linearity, 44, 47

improving, 46
liquid analysis system, 52
live spectrum, 57

not displayed during collection, 95
log (1/R) units, 58
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m
maintenance procedures, 81, 83
Manual, online, 9
mathematical operations, 73
MCT detector, 78, 80, 88
memory insufficient, 90
menu bar of OMNIC window, 5
menus, 5

customizing, 74
microscope in viewing mode, 104
microscopes, 51
mid-IR source, 15, 79
mirror velocity, 48
mixture

subtracting component from, 73
modem, 54
moving mirror

velocity, 48
Multi-Bounce HATR, 49

n

near-IR source, 79

no peaks in spectrum, 104
noise, 45, 47, 48, 56, 80, 87

caused by excessive purge flow rate, 87

increased by higher velocity, 48
noisy spectrum, 106
notebook, 65

deleting, 65

saving spectra in, 64
number of scans

signal-to-noise ratio affected by, 45

0

OMNIC
commands, 5, 6
customizing, 74
error message, 90
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OMNIC, continued
Help system, 9
installing, 3
learning how to use, 7
menus, 5
starting, 4
tutorials, 7
wizards, 7

OMNIC Integra, 52

OMNIC shortcut, 4

OMNIC window, 5
menu bar, 5
title bar, 5

opening
spectrum, 63

optical layout, 38

options
customizing OMNIC using, 74

ordering parts, 8

p

% reflectance, 58
% transmittance, 27, 58
palette, 28
Parameter checks, 58
part numbers, 8, 10
parts
ordering, 8
replacing, 8
password, 4
pasting
spectrum into spectral window, 70
spectrum into text document, 76
PbSe detector, 80
peak
labeling, 29
measuring area of, 71
measuring height of, 71
peak area tool, 71
peak height tool, 71

peaks

finding and labeling, 75
performance test, 86, 100
performance tests, 6
photometric accuracy, 44, 48

improving, 46
polystyrene sample, 20
power cable defective, 94
Power indicator, 41
power line conditioner, 53
power supply

defective, 94

replacing, 83
power switch, 39, 40
pressure regulator, 87
previewing

report, 35, 67

report template, 34
printer

specifying, 66

turning on, 40
printing

report, 34, 36, 66

specifying printer for, 66
purge, 20, 39

checking, 87

excessive flow rate, 97, 106

filter, 8, 14, 83

flow rate, 87

installing equipment for, 88

kit, 53

pressure, 87
purge gas generator, 54

q

QC comparison, 31
Quantify, 90
quantitative analysis, 44, 58, 90
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r sample, continued
specular component, 105
too thick, 103
sample compartment baseplate
installing, 16
sample cup not in place or tilted, 104
sample holder
inserting sample into, 20
installing, 16
sample interferogram, 46

readout, 28
rear panel, 39
reference spectra
restrictions, 33
uses, 30
region tool, 75
selecting spectral region for search using, 60, 61
replacing parts, 8, 83

report

adding to report notebook, 66 g i;’ SP ectrullg
creating, 34 :;i:_gmgl’s
creating and printing, 66 . g,25
enlarging, 35 :at‘l’ “‘%’7

Sl itle
previewing, 35, 67 - .
printing, 34, 36 Z:rr.lﬁhng techniques, 7

; ving

selecting template for, 34 -
template for, 66 ;r;e;?:o;g;aﬁ, ol B

report notebook, 65
adding report to, 66
deleting, 65
saving spectra in, 64

report template, 66

resolution, 48, 91
incorrect, 90
too high, 106

spectra as group, 65
spectra automatically, 64
spectrum, 25

scale commands, 68

Scan indicator, 41
flashing intermittently, 96
not blinking, 95

Roll/Zoom window, 70 g
; : too few, 106
RSVP remote diagnostics, 54 ;
scattering, 45
search
QC libraries, 31
S scrapbook libraries, 32
safety, 13 search libraries, 31
sample selecting spectral region for, 61
at wrong angle, 103 setting up, 59
held with uneven pressure or in poor contact with search expert, 31, 63
ATR crystal, 104 searching
infrared beam reflected from, 105 for comopund name, 62
inserting, 20 spectral library, 59
not in beam path, 104 selected spectrum
not in contact with ATR crystal, 106 Y-axis for, 69
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selecting
all spectra in spectral window, 67
experiment, 5, 6, 14, 16
more than one spectrum, 67
spectral region, 75
spectral region for search, 60
template for report, 34
selection tool, 68
enlarging spectrum using, 70
moving spectrum into another pane using, 71
moving spectrum into spectral window using, 70
moving spectrum using, 70
sensitivity
decreased by higher velocity, 48
service procedures, 81, 83
signal intensity, 77, 78
low, 96, 97
low in mid-IR, 96
signal-to-noise ratio
improving, 45
increased by bandwidth-limiting filter, 47, 80
increased by energy screens, 48
Single-Bounce HATR, 50
Smart accessories, 7, 49
Snap-In baseplate, 16, 51
software requirements, 89
solvent
subtracting, 73
source, 43, 78
glowing unevenly, 96
mid-IR, 15
not working, 96
replacing, 83
spectral range, 44
spectra
collecting, 16
colors for displaying, 67
deleting, 65
displaying, 5
displaying full scale, 68
displaying vertically offset, 69

spectra, continued
displaying with same Y scale, 69
displaying with Y scale of selected spectrum, 69
quality checked during collection, 57
saving, 57
saving as group, 65
saving automatically, 64
saving in folders, 64
saving in report notebook, 64
saving in user library, 30, 64
selecting multiple, 67
subtracting, 72, 73
where to save, 64
spectral cursor tool, 71
spectral library
adding to, 33
creating, 61
Qc, 31
searching, 59
searching for compound name, 62
searching for text, 62
types, 30
spectral quality checks, 23, 57
spectral range, 44
detector, 48
source, 78
spectral region
selecting, 75
selecting for search, 60, 61
spectral window, 5
moving spectrum into by dragging, 70
pasting spectrum into, 70
spectrometer
aligning, 84
cleaning, 83
components, 37
configuration, 100
diagnostics, 100
installing, 7
leaving turned on, 39, 79
maintenance, 83
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spectrometer, continued

moving, 77

not aligned, 95, 97, 105

not plugged in, 94

not properly purged, 104, 105

not yet stable, 105

operating condition shown by Bench Status
indicator, 6

performance, 79, 81, 86, 100

power switch, 40

rear panel, 39

removing or opening cover of, 77

safety, 13

service, 83

theory, 7

tour, 7

turned off, 95

turning on, 40

when to align, 77

spectrum

baseline not flat, 105

cannot be added to library, 91
carbon dioxide peaks in, 104
collecting, 16, 55

collecting and adding to user library, 62
collection and processing information, 76
color, 67

converting to other units, 27
correcting before library search, 59
derivative-shaped peaks in, 105
displayed during collection, 57
displaying full scale, 68

enlarging, 70

filename, 25

fringes or channeling in, 103
moving into another pane, 71
moving into spectral window, 70
moving up or down, 70

no peaks in, 104

noisy, 106

opening, 63
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spectrum, continued
pasting into spectral window, 70
pasting into text document, 76
saving, 25
searching against library, 59
selecting additional, 67
subtracting, 72, 73
title, 17, 76
totally absorbing bands in, 103
water peaks in, 105

Spectrum checks, 58

specular reflection, 60

specular reflection accessory, 52

stacked spectrum
moving, 71

stand-by mode, 42, 95

starting OMNIC, 4

subtracting spectra, 72, 73

subtraction factor, 73

System Validation software, 52

t

task window

closing, 75
technical support, 8
telephone numbers, 2, 8
template

for report, 66

previewing, 34

selecting for report, 34
title

spectrum, 17, 76
title bar of OMNIC window, 5
title box, 76
toolbar, 6

buttons, 6

customizing, 74
tools, 28
totally absorbing bands, 60, 103
training, 8
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transmission accessory, 52
troubleshooting, 8, 100
applications problems, 103
hardware problems, 93
turning on system, 14, 39
tutorials, 7
starting, 8

u

uninterruptable power supply, 53
unit
Y-axis, 56, 58
units
converting, 27, 58
user library
adding spectra to, 64
adding to, 33
collecting and adding spectrum to, 62
creating, 32
user name, 4

A

validation wheel, 52
velocity
for DTGS detector, 48
moving mirror, 48

velocity, continued
noise affected by, 48
sensitivity affected by, 48
too high, 97, 106

vents, 41

view finder, 61, 68, 70

\'

water

correcting spectrum for, 61
water vapor, 20, 105
web site, 2, 8
white light source, 79
Window options, 68
wizards, 7

X
X and Y values of point, 71

y

Y scale, 68

Y-axis, 68
for selected spectrum, 69
unit, 56, 58
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